
User Manual

MTS200 Series
Real-Time Analyzer

071-0076-01

This document supports MTS200 software version 2.5



Copyright � Tektronix, Inc. All rights reserved. Licensed software products are owned by Tektronix or its suppliers and
are protected by United States copyright laws and international treaty provisions.

Printed in the U.S.A.

Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the
Rights in Technical Data and Computer Software clause at DFARS 252.227-7013, or subparagraphs (c)(1) and (2) of the
Commercial Computer Software – Restricted Rights clause at FAR 52.227-19, as applicable.

Tektronix products are covered by U.S. and foreign patents, issued and pending. Information in this publication supercedes
that in all previously published material. Specifications and price change privileges reserved.

Tektronix, Inc., P.O. Box 1000, Wilsonville, OR 97070–1000

TEKTRONIX and TEK are registered trademarks of Tektronix, Inc.



HARDWARE WARRANTY

Tektronix warrants that this product will be free from defects in materials and workmanship for a period of one (1) year
from the date of shipment. If any such product proves defective during this warranty period, Tektronix, at its option, either
will repair the defective product without charge for parts and labor, or will provide a replacement in exchange for the
defective product.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the
warranty period and make suitable arrangements for the performance of service. Customer shall be responsible for
packaging and shipping the defective product to the service center designated by Tektronix, with shipping charges prepaid.
Tektronix shall pay for the return of the product to Customer if the shipment is to a location within the country in which the
Tektronix service center is located. Customer shall be responsible for paying all shipping charges, duties, taxes, and any
other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate
maintenance and care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage resulting
from attempts by personnel other than Tektronix representatives to install, repair or service the product; b) to repair
damage resulting from improper use or connection to incompatible equipment; or c) to service a product that has been
modified or integrated with other products when the effect of such modification or integration increases the time or
difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THIS PRODUCT IN LIEU OF ANY
OTHER WARRANTIES, EXPRESSED OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
TEKTRONIX’ RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE AND
EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX
AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS
ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.



SOFTWARE WARRANTY

Tektronix warrants that the media on which this software product is furnished and the encoding of the programs on the
media will be free from defects in materials and workmanship for a period of three (3) months from the date of shipment.
If a medium or encoding proves defective during the warranty period, Tektronix will provide a replacement in exchange
for the defective medium. Except as to the media on which this software product is furnished, this software product is
provided “as is” without warranty of any kind, either express or implied. Tektronix does not warrant that the functions
contained in this software product will meet Customer’s requirements or that the operation of the programs will be
uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the
warranty period. If Tektronix is unable to provide a replacement that is free from defects in materials and workmanship
within a reasonable time thereafter, Customer may terminate the license for this software product and return this software
product and any associated materials for credit or refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR
IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX’ RESPONSIBILITY TO
REPLACE DEFECTIVE MEDIA OR REFUND CUSTOMER’S PAYMENT IS THE SOLE AND EXCLUSIVE
REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX AND ITS
VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF
THE POSSIBILITY OF SUCH DAMAGES.
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General Safety Summary

Review the following safety precautions to avoid injury and prevent damage to
this product or any products connected to it.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of the system. Read
the General Safety Summary in other system manuals for warnings and cautions
related to operating the system.

Use Proper Power Cord. Use only the power cord specified for this product and
certified for the country of use.

Use Proper Power Source. Do not operate this product from a power source that
applies more than the voltage specified.

Avoid Electric Overload. To avoid electric shock or fire hazard, do not apply a
voltage to a terminal that is outside the range specified for that terminal.

Avoid Overvoltage. To avoid electric shock or fire hazard, do not apply potential
to any terminal, including the common terminal, that varies from ground by
more than the maximum rating for that terminal.

Ground the Product. This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Do Not Operate Without Covers. To avoid electric shock or fire hazard, do not
operate this product with covers or panels removed.

Use Proper Fuse. To avoid fire hazard, use only the fuse type and rating specified
for this product.

Do Not Operate in Wet/Damp Conditions.

Do Not Operate in an Explosive Atmosphere.

Keep Product Surfaces Clean and Dry.

Provide Proper Ventilation. To prevent product overheating, provide proper
ventilation.

Do Not Operate With Suspected Failures. If you suspect there is damage to this
product, have it inspected by qualified service personnel.

To Avoid Fire or
 Personal Injury
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Terms in this Manual. These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result
in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in
damage to this product or other property.

Terms on the Product. These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the
marking.

WARNING indicates an injury hazard not immediately accessible as you read the
marking.

CAUTION indicates a hazard to property including the product.

Symbols on the Product. The following symbols may appear on the product:

 

Protective Ground
(Earth) Terminal

ATTENTION
Refer to Manual

DANGER
High Voltage

Symbols and Terms
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Preface

This document applies to the Real-Time Analyzer software and hardware of the
Tektronix MTS 205 and MTS 215 MPEG Test Systems. The MTS 205 contains
only the Real-Time Analyzer; the MTS 215 also contains software for deferred-
time transport stream analysis and creation and Data Store hardware and
software for transport stream acquisition and generation.

For information about the additional MTS 215 hardware and software, refer to
the MPEG Test System User Manual, Tektronix part number 071-0078-0X.

For information about the Windows NT Workstation operating system, refer to
the Microsoft documentation that accompanied your test system.

For information about the Compaq server, refer to the Compaq documentation
that accompanied your test system.

For the latest information about MTS200 Series Real-Time Analyzer features
and bugs, refer to the MPEG Test System Software Version 2.5 Read This First
document, Tektronix part number 071-0237-0X, that accompanied your test
system or upgrade.
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Contacting Tektronix

Product
Support

For application-oriented questions about a Tektronix measure-
ment product, call toll free in North America:
1-800-TEK-WIDE (1-800-835-9433 ext. 2400)
6:00 a.m. – 5:00 p.m. Pacific time

Or contact us by e-mail:
tm_app_supp@tek.com

For product support outside of North America, contact your
local Tektronix distributor or sales office. You can also call
1-503-627-2400 between 14:00 and 01:00 UTC (GMT).

Service
Support

Contact your local Tektronix distributor or sales office. Or visit
our web site for a listing of worldwide service locations.

http://www.tek.com

For other
information

In North America:
1-800-TEK-WIDE (1-800-835-9433)
An operator will direct your call.

To write us Tektronix, Inc.
P.O. Box 1000
Wilsonville, OR 97070-1000
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Getting Started

The MTS200 Series Real-Time Analyzer (RTA) is designed to continuously
monitor an input bitstream for compliance with the MPEG-2 and DVB-SI digital
television standards. You can use the RTA to constantly monitor an array of
stream parameters to ensure decodability or you can concentrate on just a few
parameters for closer examination.

NOTE. The number of stream parameters that you can monitor at one time while
maintaining real-time error reporting depends on the compliance of the input
stream, the speed of the test system processor, and the amount of test system
RAM. Refer to Real-Time Analysis on page 1–2 for further information.

This section contains general information about logging on to your new
MTS 205 or MTS 215 Real-Time Analyzer (RTA). Refer to the MPEG Test
System Technical Reference that accompanied your system for complete
installation and interconnection instructions. Refer to the next section, Operating
Basics, for information about RTA capabilities and use.

Once you have installed the server, the Real-Time Analyzer is ready to operate.
Switch computer power on to begin the Windows NT initialization process,
which can take up to two minutes. For more information on the Windows NT
initialization process, please see the Windows NT documentation. Under normal
circumstances no action is required until the Begin Logon window appears;
when it does, press CTRL  + ALT  + DELETE  (all three keys simultaneously) to open
the Logon Information  window.

Logging On
To log on to the RTA, enter “MTS100” (without the quotation marks) in the
User name box, leave the password blank, and then press ENTER (these are the
default values set at the factory). This is the login account you should use for
most of your work.

Two additional logins are available. The first is “guest” with no password. This
level has only limited access to files and applications. The second is “administra-
tor” with “MPEG2” as the password. This user has administrator privileges. You
must use this login when performing any software upgrades.
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CAUTION. The administrator user has all the privileges of an administrator. If
you are connected to a network, you may have more privileges than you realize
within the network. It is recommended that you do not perform normal opera-
tions while logged in as administrator.

You can change the passwords if necessary; refer to the Windows NT documen-
tation for instructions. If you change any password, be sure to create a new
emergency repair disk. (See page B–1.)

Starting the Application
Once you have logged in, start the Real-Time Analyzer application by selecting
it from the Windows NT Start menu or by double-clicking the Real-Time
Analyzer icon in the Tektronix MPEG Test System window.

NOTE. The example shows the MTS 215 program group. The MTS 205 program
group does not contain all Tektronix MPEG Test System applications.

This manual explains how to use the Tektronix RTA application. If you need
information about any other Tektronix MPEG Test System application, consult
the MTS 210 User Manual, which is supplied with the MTS 215.

Real-Time Analysis
The Real-Time Analyzer analyzes the input stream as it is received and attempts
to report errors as they are detected. When the RTA cannot process and display
errors in real time, the Buffer filling  bar (in the center of the Status bar on the
bottom of the Real-Time Analyzer application window) becomes visible. The
greater the buffer filling, the less timely is RTA error and message display.
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The following factors determine the real-time performance of the RTA:

� The number and type of errors in the stream.

� The number and type of analyses that you have configured the RTA to
perform.

� The host computer processor speed. An RTA based on a 120 MHz Compaq
Prosignia platform is more likely to use the buffer than one based on a
266 MHz Compaq Proliant 1600 (serial number B080000 and later).

� The memory (RAM) that is available on the host computer. The computer
should have at least 32 Mbytes RAM; 64 Mbytes are standard on the
Proliant 1600.

If the input stream contains many errors, you can reduce buffer filling by
limiting the number of analyses performed and probes set. Refer to Automatic
Analyses on page 3–7 and to Probes on page 3–16 for more information.

Exiting the RTA Application
To exit the Real-Time Analyzer, select Exit  from the Configuration menu or
click the close box in the upper-right corner of the application window. The
current configuration is preserved and used the next time you start the applica-
tion. In the default configuration, information and error messages (up to
2048 kbytes) are automatically saved in the Windows NT Event Viewer. No
other information is saved.

Close
button

Shutting Down the Computer
To avoid loss of data and possible problems during subsequent Windows NT
initialization, always shut down Windows NT before switching computer power
off. To shut down Windows NT, select Shut Down from the Start menu.

Select Shut down the computer? in the resulting Shut Down Windows dialog
box and then click Yes. After a few seconds, the Shutdown Computer window
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appears with the message that “It is now safe to turn off your computer.” You can
now power off the Proliant server.

CAUTION. Do not switch computer power off before the message “It is now safe
to turn off your computer” appears. Doing so may result in lost data and
difficulty in restarting Windows NT.
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Operating Basics

The Real-Time Analyzer (RTA) is designed to continuously monitor an input
bitstream for compliance with the MPEG-2 and DVB-SI digital television
standards.

You can use the RTA to constantly monitor an array of stream parameters to
ensure decodability or you can concentrate on just a few parameters for closer
examination. For convenience and flexibility, the RTA performs analysis in three
ways:

� Basic analyses are performed whenever the RTA monitors an input stream.
You cannot disable the basic analyses.

� Automatic analyses evaluate important input stream parameters, including
most of the parameters identified in the DVB-MG guidelines (ETR 290). In
normal circumstances, all automatic analyses are enabled for constant
monitoring. However, for maximum flexibility, the Real-Time Analyzer
makes it possible to enable or disable these analyses either in groups or one
at a time.

The RTA shows pass/fail results of all DVB-MG-recommended evaluations
in one convenient display, the DVB-MG view.

� Probes are user-initiated analyses of table sections, program clock references
(PCRs), or elementary stream time stamps (PTS/DTS).

This section contains four step-by-step tutorials intended to introduce you to
RTA capabilities, features, and techniques. Perform each tutorial with your own
input stream and then spend some time experimenting with the various configu-
ration and analysis options. Consult the Reference section of this manual if you
need more information on any topic. If you have an MTS 215, be sure to capture
a portion of the stream and then examine it more closely with the deferred-time
analyzer. Doing so will enable you to get the most out of your Tektronix MPEG
Test System. The tutorials begin on the following pages:

� Monitoring an Input Stream, page 2–2

� Using the DVB-MG View, page 2–12

� Setting Probes, page 2–16

� Capturing Input Streams (MTS 215 only), page 2–25

All tutorials assume that you have connected an input to the rear panel of the
instrument and started the machine; refer to Getting Started on page 1–1 for
instructions. The tutorials also assume that you have a basic level of familiarity
with Windows NT 4.0 or Windows 95. If you are not comfortable with either
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operating system, please review the Windows NT documentation that accompa-
nied your test system.

Monitoring an Input Stream

1. Double-click the Real-Time Analyzer icon in the Tektronix MPEG Test
System program group window.

The RTA application window opens.

2. Open the Configuration menu and select Restore Settings.

3. Click OK  in the resulting RTA  dialog box.

4. Open the Configuration menu again and select Settings.

5. Choose the appropriate input type in the Hardware Configuration tab of the
resulting Settings window..



Operating Basics

Real-Time Analyzer User Manual 2–3

6. Select the General Settings window tab and then choose either MPEG-2 or
DVB mode, depending on the type of stream you intend to monitor.

7. Click OK  on the bottom of the Settings window to accept your changes and
close the window.

NOTE. If you have selected either ASI input or DVB mode, you may find it
convenient to save the current configuration for later recall. Then, to return to a
base configuration, you can load the saved setup instead of restoring the
standard configuration, which uses the parallel input and modified ECL output
level. Refer to Saving and Restoring Configurations on page 3–69 for more
information.

8. Click the Start analysis toolbar button.

The RTA hardware (the PIA board) is initialized and analysis begins. The default
display resembles the next screen capture.

Icons that represent stream items appear in the Hierarchic window pane. The
rectangular lozenge above each icon is an error indicator. Indicators are normally
gray in the standard RTA configuration. If any of the indicators turn red, you
know that an error is occurring in or under the stream item; if the indicator then
turns orange, you know that the error has stopped. A complete discussion of the
Hierarchic view begins on page 3–33.

The Program Allocation panel of the Statistic view appears in the Client window
pane. The panel uses a pie chart and table to show how the services (PSI/SI,
programs, and null packets) use the available input bandwidth. A complete
discussion of the Statistic view begins on page 3–50.
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Information messages appear in the General Message window pane. Error
messages, preceded by a red round indicator, also appear when input errors are
detected. A complete discussion of the Message window and Message views
begins on page 3–43.

The preceding steps are sufficient to begin monitoring an input stream. Continue
with this tutorial to learn more about using the RTA.
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9. Press F8 (on the keyboard); notice what happens to the Hierarchic view. If
you like, click on and drag the borders between window panes to enlarge the
hierarchic pane.

10. Now press F9 and F10 in succession while paying attention to the Hierarchic
view. At each step, another level of the input multiplex hierarchy is revealed.

Press the F8 function key to show
the second hierarchy level.

Press the F10 function key to reveal
all levels and items in the hierarchy.

11. Find the PAT icon near the top of the hierarchy. You may have to use the
vertical scroll bar to see the top. Double-click on the icon, and a PAT
Message view opens in the Client window pane to the right of the hierarchy.

This Message view contains information and error messages that apply only
to the PAT. If your input stream is reasonably compliant with the mode you
selected in step 6, there may be only one initial PAT:Update message.

Exploring the
Hierarchic View
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12. Double-click the PAT: Update message. A Detail of Message window opens
to display information that has been logged to the Windows NT Event
Viewer application log.

13. Click OK to close the Detail of Message window.

14. Click the Client window pane Close box to close the PAT Message view.
The Close box is at the right end of the RTA menu bar, immediately below
the application window size boxes. Do not click the application close box;
doing so will exit the Real-Time Analyzer application.

Don’t click here

Click here

15. Select the Hierarchic view PAT icon again and right-click to open the
shortcut menu.
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16. Select View section analysis. A PAT section analysis view opens in the
Client window pane. Notice that the view has two sub-views. The left
sub-view contains a hierarchical representation of the table section. The right
sub-view shows the contents of the currently selected left sub-view folder.

The first eleven items in the right sub-view are preceded by a round indicator.
The indicator identifies an item as a table section field; it is green when the field
contents are correct and is red if the field contents do not comply with the
applicable MPEG-2 standards.

17. Press F2 and notice that the numbers in the Value column (in the right
sub-view) change to decimal base. Press F2 again to toggle the numbers back
to hexadecimal base.

18. Click on the gray vertical bar that divides the two sub-views; then drag the
bar to the right to reveal all program numbers in the left sub-view.

19. Drag the vertical scroll box down, if necessary, to see the remainder of the
right sub-view. Notice that each second-level folder in the left sub-view has a
corresponding folder item in the right sub-view. Each folder icon is green if
no errors are detected in the represented item; otherwise, the icon is red.

20. Click on one of the “program number 0x...” folder icons in the left sub-view.
The right sub-view changes to show the PAT section fields that assign a PID
to the the NIT (program number 0x0) or to a particular program in the
stream.
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Note that in several DVB-SI tables, the left sub-view hierarchy can contain more
than one sub-level. You can expand and collapse levels as you would in a
Windows NT Explorer hierarchy.

21. Click the Client window pane Close box to close the PAT syntax view.

22. Right-click on the PAT icon to again open the shortcut menu. This time,
select View section rate. As you might expect, a section rate view opens in
the Client window pane.

23. Watch the time cursors proceed across the graphs for a few seconds. If the
PAT appears in your input stream as often as required by the MPEG-2
standard, the graph text is green and the plot lines are pale blue. Both the
text and the plot turn red if an error is detected.

24. Move the pointer to the bottom of the Client pane and click the Statistic
view tab.
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25. The Statistic view consists of five tabbed panels. When the view first opens,
most tabs are hidden by the horizontal scroll bar. Click the thin split box at
the left end of the horizontal scroll bar and drag to the right to shorten the
scroll bar and reveal the last two tabs.

26. Click each tab in turn to familiarize yourself with the information that each
contains. Notice that the Program Alloc[ation], TP Error Indicator, and
Unsynchro Packets tabs pertain to the input stream as a whole, while the PID
Alloc[ation] and Continuity Counter tabs pertain to the selected service
(PSI/SI, programs, null packets, and unreferenced ghost packets).

The remainder of this section explains features of the PID Allocation and
Program Allocation panels. For more information about the Continuity Counter,
TP Error Indicator, and Unsynchro Packet panels, refer to the discussion of the
Statistic view that begins on page 3–50.

27. Return to the Program Allocation panel by clicking the Program Alloc tab.
Notice that the pie chart provides a quick graphic overview of input stream
contents while the table to the right provides the equivalent numeric data.

Service or program name

Portion of the input stream
used by the service or program

Transport rate of the
service or program

Exploring the
Statistic View
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28. Notice that the yellow pie chart slice represents the service information (PSI
or PSI/SI). Now double-click on any other slice of the chart. The PID
Allocation panel replaces the Program Allocation panel in the Statistic view.

Service-selection buttons PID list

The PID Allocation panel contains a dynamic transport rate display for each PID
in the selected service (PSI/SI, program, null packets, or unreferenced ghost
packets). Notice that the “pressed down” service-selection button and the PID list
on the right side of the panel both correspond to the pie slice that you have
double-clicked. The service in the above example is composed of only one PID.

29. Click the PSI (MPEG-2 mode) or PSI/SI (DVB mode) button to see the
transport rates of all service information tables in the input stream.

The PAT is the first PID listed. The rate bar shows the current transport rate,
which may change as often as twice per second, as well as the highest and lowest
rates since you began monitoring.

Current
transport rate

Previous
maximum rate

Previous
minimum rate

Current
transport rate

You can set transport rate error limits for any PID in the stream through the
Hierarchic view. When you do so, the limits and any errors are visible on the
PID allocation panel.
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30. To set error limits for the PAT, position the cursor over the PAT rate bar and
click the right-hand mouse button.

31. In the resulting dialog box, select both Low limit check and High limit
check. Then enter a low limit that is less than the previous minimum and a
high limit that is greater than the previous maximum. Click OK  and notice
the changes in the PID Allocation Statistic view.

The limits now define the ends of the rate bar. Low Errors:  and High Errors:
readouts now appear to the left of the bar to report the number of half-second
intervals in which the rate has violated the limits.

Notice also that the round indicator at the right end of the PSI (or PSI/SI)
selection button has changed from gray to green. The indicator turns red when a
rate limit error is detected.

Rate error indicator

The arrangement and colors of the rate bar and rate readout numerals also change
when errors occur. Refer to PID Allocation on page 3–3 for a complete descrip-
tion and explanation.
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Using the DVB-MG View
DVB-MG is the DVB working group that recommends measurements and
controls to be performed on all elements of the digital television chain. The RTA
can perform all but a few of the DVB-MG recommended tests as a stream is
received, and performs most of them automatically in the standard configuration.
The DVB-MG view presents pass/fail results of the recommended tests in one
display; you can use the DVB-MG view to get a quick overview of the DVB
compliance of the input stream.

Perform the following steps to familiarize yourself with the DVB-MG view;
refer to Appendix A: DVB-MG Measurements for additional information about
the DVB-MG recommendations and tests.

1. If the Real-Time Analyzer is not running, start the program and configure it
as described in steps 1 through 8 beginning on page 2–2. Then continue
with step 3, below.

2. If the RTA is running, stop analysis and restore the original settings before
proceding.

a. Click the red stoplight toolbar button and then select Restore standard
from the Configuration menu.

b. If you are using a DVB input stream or are receiving your input through
the ASI connector, open the Configuration menu and select Settings.
Make the appropriate settings on the Hardware Configuration and
General settings tabs. Click OK  to confirm the changes and close the
Settings window.

c. Click the green stoplight toolbar button to restart analysis.

3. Open the View menu, click DVB-MG view, and select Detailed.

The detailed DVB-MG view opens in the Client window pane.



Operating Basics

Real-Time Analyzer User Manual 2–13

The view lists every DVB-MG test that the RTA can perform; a colored indicator
light accompanies each listing to shows the status of the test. The colors have
much the same meaning as in the Hierarchic view:

� Gray signifies that the RTA is not currently performing the test.

The indicators for tests 2.3 (PCR_error), 2.4 (PCR_accuracy_error) and 2.5
(PTS_error) are gray in the standard RTA configuration because those tests
are conducted with user-initiated probes. Refer to the tutorial, Setting Probes
on page 2–16, to learn more about RTA probes.

Other indicators may be gray because your input stream does not contain the
applicable table. MPEG-2 streams, for example, do not contain SI tables;
therefore, tests 3.2 through 3.8 cannot be performed on a non-DVB stream.

� Green signifies that the test is running and that no errors have been detected.

� Red signifies that the RTA detects the error in the input stream.

� Orange signifies that at least one error has occurred since monitoring began
(or since the last error reset) but that it is not currently present in the input
stream.

The DVB-MG view of a fully-compliant stream will contain only green or gray
indicators. When the stream does contain errors, you can double-click on a red or
orange indicator to open a client view of messages pertaining to the particular
DVB-MG error.
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If the input stream contains so many errors or message events that messages
quickly scroll off the top of the window, click the Freeze views toolbar button to
pause window updates. Then use the vertical scroll bar to locate the applicable
error message.

You can change the error limits (thresholds) for some DVB-MG tests, although
doing so may not be consistent with DVB-MG recommendations.

4. Choose Settings from the Configuration menu and then select the Section
Rates Analysis tab on the resulting Settings window.

5. The DVB-MG-recommended maximum interval between PAT sections is
500 ms. Highlight the PAT setting and change it to 50 ms.

6. Click OK  to confirm the change and close the Settings window.

7. The DVB-MG indicator for parameter 1.3.1, the PAT section rate, should be
red. Locate the corresponding message in the general Message view.

8. Double-click on the error message to retrieve message details from the
Windows NT Event Viewer. Notice, on the bottom of the resulting Detail of
Message window that the message ID represents more than one error. If you
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close the window and then reopen it (by again double-clicking the PAT error
message), the number is greater.

9. Close the Detail of Message window. Then choose Settings from the
Configuration menu. Select the Section Rates Analysis tab and click Restore
default to reset the PAT interval value to 500 ms. Finally, click OK to
confirm the change and close the Settings window.

10. If necessary, click on the DVB-MG view tab at the bottom of the Client
window pane to bring the view back to the top of all client views.

Restoring the default PAT interval should change the PAT section rate DVB-MG
indicator to orange (if it remains red, your input stream contains other PAT
section rate errors). Click Reset past errors in the lower-left of the DVB-MG
view. The indicator should change back to green.

PAT section rate indicator



Operating Basics

2–16 Real-Time Analyzer User Manual

11. Once again choose Settings from the Configuration menu. Then select the
Automatic Analysis tab of the Settings window.

12. Click the three Reset All buttons to deselect all automatic analyses. Then
click OK  to confirm the changes and close the Settings window.

Notice, on the DVB-MG view, that only the TS_sync_loss indicator remains
colored; all others have become gray, signifying that the associated tests are no
longer being performed. You can disable tests if you want to free RTA processing
and buffer resources for other functions, which may be necessary if you want to
set several probes and see the results in real time. Be aware, however, that the
tests remain disabled until you again set them through the Configuration menu or
you restore the standard configuration (even if you exit and restart the Real-Time
Analyzer application).

13. Reopen the Settings window and click the three Set All buttons on the
Automatic Analysis tab. Then click OK  to accept the changes and close the
window.

Setting Probes
Real-Time Analyzer probes are simply user-initiated analyses. Two of the
probes, PCR and PTS/DTS, fulfill DVB-MG recommendations.
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1. If the Real-Time Analyzer is not running, start the program and configure it
as described in steps 1 through 8 beginning on page 2–2. Then continue
with step 3, below.

2. If the RTA is running, stop analysis and restore the original settings before
proceding.

a. Click the red stoplight toolbar button and then select Restore standard
from the Configuration menu.

b. If you are using a DVB input stream or are receiving your input through
the ASI connector, open the Configuration menu and select Settings.
Make the appropriate settings on the Hardware Configuration and
General settings tabs and then click OK  to close the settings window.

c. Click the green stoplight toolbar button to restart analysis.

3. Press F8 to reveal the second level in the Hierarchic view.

4. Select a PMT hierarchy icon that is accompanied by a gray error indicator, if
possible, and then right-click to open the shortcut menu.

Notice the two commands, PCR probe and View PCR analysis. Either
command sets the PCR probe to monitor the clock references that apply to the
selected program.

PCR Probes



Operating Basics

2–18 Real-Time Analyzer User Manual

5. Select View PCR analysis. The icon error indicator changes to green or red,
signifying that the PCR probe is set. At the same time, a PCR analysis view
opens in the Client window pane.

Refer to PCR Analysis View on page 3–64 for information about the view. If the
PCR precision and interval is within the DVB-MG-recommended error limits,
the Min and Max readouts are green and the plots are light blue. You can change
the PCR error limits, but remember that doing so will put the DVB-MG view out
of compliance with DVB-MG recommendations.

6. Make a note of the Min: and Max: PCR intervals shown on the lower PCR
analysis view graph.

7. Choose Settings from the Configuration menu and then click the PCR
Analysis tab on the resulting window.



Operating Basics

Real-Time Analyzer User Manual 2–19

8. Depending on your operating mode, change either the DVB mode interval or
the MPEG-2 mode interval to a value that is between the actual minimum
and maximum that you recorded in step 6.

9. Click OK  to accept the new value and close the Settings window.

The new PCR interval setting should have the following results:

� The indicator above the PMT hierarchy icon should change color. It should
quickly become red to indicate the presence of PCR interval errors. After
that, it may turn orange in the times between errors. If the indicator remains
green, reopen the Settings window and reduce the interval setting.

� Error messages should begin appearing in the message window pane.

10. Open the RTA View menu, click DVB-MG view, and select Detailed.
Notice that setting the PCR probe has changed the information for recom-
mended tests 2.3 and 2.4 (near the center of the view).

Number of
PCR probes set

Red or orange indicator

Green indicator

11. Open the Configuration menu and select Settings. Then click the Probes List
tab. Notice that the PCR probe appears on the Probes List on the right side
of the tab.

12. Double-click the PCR probe entry to remove it from the Probes List and
then click OK on the bottom of the Settings window. Doing so removes the
PCR probe. Notice that the DVB-MG view indicators for the PCR parame-
ters (2.3 and 2.4) are now gray.
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13. Close the DVB-MG view to reveal the PCR analysis view (recall that the
Client view Close box is at the right end of the RTA menu bar, immediately
below the application window size boxes). Notice that the graphs are no
longer updating because the probe has been removed.

14. Click the Client window pane Close box to close the PCR Analysis view.

15. Open the View menu and select Reset past errors (and notice that F4 is the
F-key equivalent). The indicator above the PMT icon (from which the probe
was removed) should change from orange to gray.

16. Restore the default PCR interval setting.

a. Choose Settings from the Configuration menu and select the PCR
Analysis tab on the resulting window.

b. Click Restore default, on the lower-right of the settings tab.

c. Click OK  on the bottom of the Settings window to confirm the default
settings and close the window.

17. Press F9 to reveal the third level of the hierarchy. You can now see elementa-
ry stream icons under the PMT icons.

Notice that some elementary stream icons have green clock symbols on the
upper-right; those streams contain PCRs. Several elementary stream icons may
have a blue padlock symbol on the lower-left; the lock symbol indicates that the
stream is scrambled.

18. Find an icon that represents an unscrambled audio or video stream. The icon
error indicator should be gray. Make a note of the stream PID. (The item PID
appears immediately to the right of all hierarchy icons.)

19. Open the Configuration menu and select Settings. Select the Probes List tab
of the Settings window.

20. Set a PTS/DTS probe on the elementary stream that you identified in
step 18.

PTS/DTS Probes
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a. Highlight Elementary Stream in the Table type list on the left side of
the tab.

b. Enter the stream PID in the PID box. Notice, but do not select, the ALL
option; this option sets a probe on every eligible elementary stream in
the input multiplex.

c. Highlight PTS/DTS in the Probe Type list.

d. Click Add.

a

d

b

c

e. Click OK  on the bottom of the Settings window to set the probe and
close the window.

The hierarchy icon error indicator immediately changes from gray to either green
or red.

21. Through the View menu, open the detailed DVB-MG view.

Notice that the PTS_error indicator (parameter 2.5), like the icon error indicator,
is green, red, or orange, depending on the contents of your input stream. The
DVB-MG error condition is an interval of more than 700 ms between consecu-
tive PES packets that contain a presentation time stamp. You cannot change the
PTS/DTS error interval in the RTA.
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22. In the Hierarchic view, select the icon that represents the elementary stream
that you are probing and then right-click to open the shortcut menu.

Notice that PTS/DTS probe is selected because you set the probe through the
Configuration menu.

23. Select View PTS/DTS analysis. A PTS/DTS analysis view opens in the
Client window pane.

If the RTA detects PTS/DTS errors, the Max: readout text becomes red and the
interval plot line changes from blue to red in regions that correspond to the
errors.

24. If the selected elementary stream contains PTS/DTS errors, look for error
messages in the general Message view. Remember that you can double-click
on a message to retrieve the error information logged to the Event Viewer.

25. Again select the hierarchy icon of the elementary stream that you are
probing; right-click to open the shortcut menu and then click PTS/DTS
probe. Doing so removes the probe.

Notice that, because the probe is removed, the PTS/DTS analysis view no longer
updates.

26. Close the PTS/DTS analysis view (click the Client window close box, not
the RTA close box).
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Closing the PTS/DTS analysis view reveals the DVB-MG view. Notice that the
PTS_Error indicator (parameter 2.5) is now gray.

27. Open the Configuration menu and select Settings.

The Probes list Settings tab should still be selected. Notice that the PTS/DTS
probe is no longer listed in the Probes List box.

28. Close the Settings window.

The InterSI probe checks for errors within and between DVB-SI tables. Continue
with this tutorial only if your input stream contains SI tables (for example, EIT,
BAT, and SDT).

29. Stop analysis (click the red stoplight toolbar button) and then restart it (click
the green stoplight button).

Restarting analysis resets all past errors and removes any extra views from the
Client window. In this case, the DVB-MG view closes.

30. Press F7 to hide all but the top hierarchy level.

31. Select the NIT icon and open the shortcut menu (right-click). Select InterSI
probe.

If not previously red or orange because of errors detected by basic or automatic
analysis, the error indicators of the BAT, EIT, NIT, and SDT icons now change
from gray to signify that the InterSI probe is set.

After a few moments, depending on the contents of your input stream, one or
more of the indicators may become red and then perhaps orange to signal InterSI
errors. InterSI information, warning, and error messages also appear in the
General message view. You can also double-click an affected icon to open a

The InterSI Probe
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item-specific message window. Refer to The InterSI Probe on page 3–16 for
more information.

32. Select the icon of the SDT or an EIT and open the shortcut menu. Notice that
InterSI Probe is selected.

You can set and remove the InterSI probe through any SI table icon or through
the Probes List Settings window tab.

33. Through the Configuration menu, open the Settings window and select the
Probes List tab.

34. Select the InterSI entry in the Probes List box and the click Remove (or
simply double-click the list entry). Click OK  to confirm the change and
close the Settings window.

35. If any of the SI table icon error indicators remain orange, press F4 to reset
past errors. The indicators change to gray unless the automatic analyses
detect other SI table errors.
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Capturing Input Streams (MTS 215 only)
If you have an MTS 215, you can easily capture and store a portion of the input
stream on the Data Store disks for deferred-time analysis or other use of the data.

1. Use the shielded cable provided with the MTS 215 Real-Time Analyzer,
Tektronix part number 174-3799-0X, to connect the 25-pin RTA output to
the 25-pin Data Store (parallel/serial ECL) input.

Install RTA-to-Data
Store board cable

RTA I/OData Store I/O

NOTE. You must use a shielded cable to maintain EMC compliance.

2. Start the Data Store Administrator application by double-clicking the Data
Store Administrator icon in the Tektronix MPEG Test System window.

Hardware Setup
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3. Confirm that there is a Single shot partition and that it is large enough hold
the data you intend to store. Repartition the disks if necessary; see the
MPEG Test System User Manual for instructions.

NOTE. Repartitioning the Data Store disks erases all existing files. Before
proceeding, confirm that the Data Store disks do not contain important and
irreplaceable data

4. Check the File information  list and confirm that no file on the single shot
partition is named Rta.trp; if such a file does exist, delete the file and then
compress the disks (if necessary) to completely remove the file from the
partition.

5. Minimize the Data Store Administrator window.

6. If the Real-Time Analyzer is not running, start the program and configure it
as described in steps 1 through 8 beginning on page 2–2. Be sure to start
analysis before continuing with this tutorial and making any Filtering or
Data Storage Start/Stop settings selections.

7. Choose Settings from the RTA configuration menu and then select the
Hardware Configuration tab. Change the Output Level setting to Modified
ECL  if necessary.

8. Select the Filtering Configuration Settings window tab. Notice that you can
select PID based filtering and specify the tables, programs, or elementary
streams that you wish to capture and store. Refer to Filtering Configuration
on page 3–91 for instructions. For this tutorial, select No filtering mecha-
nism to capture all packets contained in the input stream.

NOTE. PID-based filtering can result in a relatively low data output rate. If you
intend to capture filtered output, be sure to consider the data rate when you
specify (in the following step) the amount of the stream to capture. It can take
several minutes, for example, to capture 5 Mbytes of output that contains only SI
table sections.

RTA Software Setup
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9. Select the Data Storage Start/Stop Settings window tab. Through this tab
you can specify one or more Stop conditions, such as an external trigger or
a DVB-MG error. Manual stop is always selected. You can also specify how
much of the input stream (or filtered output) is to be captured.

Refer to Data Storage Start/Stop on page 3–92 for a full discussion of the
Data Storage Start/Stop settings tab.

10. Click Reset All (immediately below the Stop conditions list) to ensure that
only Manual stop is selected.

11. Confirm that Manual Stop is highlighted in Stop conditions list as shown
below.

12. In the After event area at the lower-right of the settings tab, click Seconds
and then enter 15 in the text box. Then click Bytes to see the size of the file
to be stored. The number of bytes depends on the transmission rate of your
input stream; the example below is for a 30 Mbit/s input stream.

13. Click OK  to confirm all settings changes and close the Settings window.

14. Click the Start acquisition toolbar button.Stream Capture
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NOTE. The message “Acquisition stopped! File already exists” can appear if you
attempt to start acquisition when a file named Rta.trp exists on the single shot
data store partition. When the message appears, you must delete the file and
compress the data store disks before you can proceed with data storage. Refer to
the MPEG Test System Deferred-Time Applications User Manual for information
about using the Data Store Administrator application.

15. Wait approximately two seconds and then click the Stop acquisition button.

NOTE. If you attempt to stop acquisition before the test system receives enough
input to satisfy the Before event setting, the following message appears:

If you click Yes, acquisition stops and no file is saved. If you click No, acquisi-
tion continues; you can stop it later, after enough input has been received.

16. A message appears at the left end of the Real-Time Analyzer status bar to
show the time remaining for the data capture.

At the same time, “REC” and a cassette tape icon alternate at the right end of the
status bar. Shortly after the capture period is over, a flashing red WAIT symbol
replaces REC to indicate that the RTA is creating a file on the Data Store disks.
The entire process for this tutorial example takes approximately 30 seconds.
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When the WAIT symbol stops flashing, a “Data are stored...” message appears in
the General message view.

NOTE. During data storage, the test system must first acquire the event trace
data and then rewrite that data to a contiguous file at the beginning of the free
space on the data store disks.1 As a result, the time required to save an event
trace file—from stop condition detection to the appearance of the “Data are
stored...” message—can be up to twice the time required to acquire the event
trace data. In extreme circumstances, such as saving 16 Gbytes of input
immediately following a stop condition, data storage through the RTA can take
over one hour.

Be aware of this limitation when configuring the RTA to store a large event trace
file, as you cannot run the Data Store Administrator, Deferred-Time Analyzer, or
Multiplexer applications during RTA data storage.

17. Maximize the Data Store Administrator window.

18. Select FAT Read from the File menu (or press F5) and then confirm that the
file MnStop00.trp is on the Single Shot partition.

NOTE. In a standard MTS200 Series test system, the saved file size must be an
exact multiple of 96256 bytes. Therefore, the resulting file can be up to 96255
bytes smaller than the total size specified in the Before Event and After Event
size fields.

19. Minimize the Data Store Administrator application window.

If you repeat steps 14 through 18, you will see that another file, MnStop01.trp, is
added to the single shot Data Store partition. The number at the end of the file
name increments to permit saving stream data before and/or after several similar
data storage stop events.

1 Refer to the MPEG Test System Deferred-Time Applications User Manual for additional information about file manage-
ment on the data store disks.
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You can also configure the RTA to monitor a stream and automatically save a
number of “event trace” files of data immediately before and/or after similar
DVB-MG errors.

20. Select Settings from the Configuration menu and click the Data Store
Start/Stop tab.

21. In the Stop conditions list, click the “+” box to the left of the “DVB-MG
tests: Level 1” item to expand the hierarchy below that item.

22. Click the hard disk icon of the “1.1 TS_sync_loss” stop condition; a green
check mark appears to indicate that the Stop condition is enabled.

23. Select Continuous acquisition to enable the capture of several
DVB11nn.trp event trace files.

At this time, the Stop conditions portion of the Data Storage Start/Stop tab
resembles the following illustration.

Step 22

Step 23

24. Click OK  to confirm your selections and close the Settings window.

25. Click the Start acquisition command button to begin monitoring the input
stream for sync loss error events.

26. After approximately two seconds, disconnect the cable from the RTA input
connector on the rear panel of the MTS 215 Doing so will cause a sync loss

Continuous Acquisition
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error. Notice that when an error is detected, the Stop acquisition button is
grayed.

27. Reconnect the input cable. After a few seconds, the message “Data are stored
in CARB file: carb0\mono\DVB1100.trp” appears at the bottom of the
general message window.

28. Repeat steps 26 and 27 twice to capture two more error trace files.

29. After “Data are stored in CARB file: carb0\mono\DVB1102.trp” appears at
the bottom of the general message window, click the Stop acquisition
toolbar button.

30. When the “Data are stored in CARB file: carb0\mono\MnStopnn.trp”
message appears, maximize the Data Store Administrator application
window.

31. Select FAT Read from the Data Store Administrator File menu (or press F5)
and then confirm that several DVB11nn.trp files are on the Single shot
partition and that the last file listed is MnStop0n.trp.

This tutorial example is contrived to show how you can use data storage to
capture data immediately preceding or following infrequent errors. You can
configure the RTA to monitor a stream for a number of different DVB-MG errors
for an extended period without user attention or input. You can later analyze any
resulting event trace files with the MPEG System (Deferred-Time) Analyzer to
diagnose the cause or effects of the error event.

32. When you are done experimenting with data storage, delete the
MnStopnn.trp and DVB11nn.trp files from the Data Store disks and exit the
Data Store Administrator.

33. Stop analysis and restore the standard configuration to ensure that the
settings used in this tutorial do not cause unexpected results when you again
use the Real-Time Analyzer.

This ends the data storage tutorial.
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Analysis

This section explains the various types of Real-Time Analyzer analyses in detail.
As explained in the Operating Basics section of this manual, the RTA performs
three classes of analysis: basic analyses, automatic analyses, and probes.

Basic analyses are fundamental to Real-Time Analyzer operation and cannot be
disabled. Refer to Basic Analyses on page 3–1.

Automatic analyses are all performed by default in the standard Real-Time
Analyzer configuration; however, you can disable these analyses one-by-one
through the Configuration menu. Disabled automatic analyses remain disabled
until reselected or until you restore the standard RTA configuration. Exiting and
restarting the Real-Time Analyzer does not restore the standard configuration.
Several of the automatic analyses satisfy DVB-MG recommendations; you
should leave these analyses enabled if you intend to monitor the DVB-MG
compliance of the input stream. Refer to Automatic Analyses on page 3–7.

Probes are user-initiated analyses that must be set to monitor and analyze certain
selected features of the input stream. No probes are active in the standard
configuration. Once set, probes remain active until removed, even if you exit and
restart the Real-Time Analyzer application. The four types of RTA probes are
section syntax, PCR, PTS/DTS, and InterSI. Refer to Probes on page 3–16.

Basic Analyses
The RTA always checks for Synchronization and monitors Transport Rates.

If the RTA cannot achieve synchronization, it reports an error in the General
Message view. This error is the same as DVB–MG error 1.1, TS_sync_loss. If
synchronization cannot be achieved, no other tests or analyses can be conducted.

In transport rate analysis, the RTA calculates the average bit rate of each PID in
the input stream and displays the results in the Program Allocation and PID
Allocation panels of the Statistic View. The analysis is completely automatic and
cannot be disabled. You can set upper and lower error limits for any PID in the
stream; the RTA then alerts you when the transport rate of the selected PID is
outside of the desired range.

The RTA calculates transport rates every 500 ms, but uses a smoothing period for
transport rate averaging. In the default configuration, the RTA averages the
reported transport rate over one second, or two 500 ms sample periods. You can
increase the smoothing period up to 10 seconds through the Settings command

Synchronization

Transport Rate Analysis
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on the Configuration menu. Refer to Statistic Analysis on page 3–85 for further
information.

Program Allocation. The Program Allocation panel of the Statistic view shows the
bandwidth allocation of the input multiplex. The yellow slice of the pie chart
represents PSI/SI information; each remaining colored slice represents a
program, null packets, or unreferenced (ghost) packets. The pie chart and
accompanying color-coded list provide both a graphic and numeric report of
bandwidth usage. Both the numeric data and the pie chart update every 500 ms
to give a near-instantaneous report of input stream composition.

The Program Allocation panel occupies the Client window pane by default
whenever you start stream analysis.

Service or program name

Portion of the input stream
used by the service or program

Transport rate of the
service or program

The Reused rate is the rate of shared items (that is, PIDs shared between
programs).

The Used rate is the transmission rate less the Null Packet rate.

Double-click on a slice of the pie chart to change to the PID allocation panel
with the corresponding program already selected.
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PID Allocation. The PID Allocation panel provides a more detailed, program-level
view of input stream bandwidth allocation. The panel also indicates whether or
not transport rate error limits are set and signals rate errors when they occur.
Click a button on the left side of the panel to select a service and see the
instantaneous, previous maximum, and previous minimum multiplex rates for
every PID in the service. As in the Program Allocation panel, all values update
every 500 ms.

Click to reset previously
detected transport rate errors

Click a button to select
a service or program

Information about each
component of the selected

service or program

Transport rate statistics of the
selected service or program

The banner in the upper-right of the panel contains information about the
selected service. The area below the banner lists each PID in the service and,
with graphics and text, reveals additional information about the stream item
identified with that PID. If the program/service contains more than a few PIDs,
you may have to use the vertical scroll bar to view the information for every
PID.
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Notice the following PID Allocation display features:

� The icon corresponds to the item type as it does in the Hierarchic view. In
the example above, PID 0x121 carries a video elementary stream.

� The number immediately to the right of the icon is the proportion of the
service used by the PID. In the example, PID 0x121 accounts for 80.20% of
the program. The length of the outline bar also corresponds to the propor-
tion, as you can see in the following edited screen capture.

� The rate bar shows the current rate and the minimum and maximum rates
measured since the start of analysis.

Current
transport rate

Previous
maximum rate

Previous
minimum rate

Current
transport rate

Because no error limits have been set in the above examples, the RTA displays
all transport rate values with green numerals.

Setting Error Limits. You can set upper and lower transport rate error limits for
individual stream items so the RTA can alert you when the transport rate is
outside of the desired range. To do so, right-click in the horizontal region of the
PID list that contains the item icon and rate bar. In the resulting dialog box,
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select Low limit check, High limit check, or both and then enter the desired
error limit value or values.

Click OK  to accept the error limits and close the dialog box. The new limit
values change the appearance of the PID Allocation panel.

Because they are outside the transport rate range encountered so far, the limits
define both ends of the rate bar and appear in black text. The number of errors
detected (in this case, 0) is listed just to the right of the PID icon. Notice also
that the indicator “light” on the program button turns green to indicate that an
error limit is set.

The following conventions apply to the PID Allocation panel transport rate
display:

� The minimum, maximum, and instantaneous rates are each shown with green
numerals when the value remains within the user-specified low and high
limits. The RTA shows the instantaneous rate in red when it violates either
limit, while the min and max numerals become and remain red when the
value goes outside of the associated limit.

� Once a limit has been violated, the region of the bar between the limit and
the actual min or max value becomes red.

� The number of Low Errors  reported is the number of 500 ms samples in
which the actual rate has been below the lower limit.

� The number of High Errors  reported is the number of 500 ms samples in
which the actual rate has been above the upper limit.

� The instantaneous rate is always displayed above the rate bar.
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� The minimum rate, maximum rate, low limit, and high limit are displayed
from the lowest value to the highest. The lower and higher values are
displayed at the left and right ends of the bar and define the scale of the bar.
The other values are displayed below the rectangle.

If you set narrower limits and the transport rate goes above and below the
specified range, the PID allocation panel may resemble the following capture.

Notice that the program button indicator color follows the same convention as
the hierarchy icon error indicators (and all other indicators in the RTA):

� Gray signifies that no transport rate probe is set for the program.

� Green signifies that a transport rate probe is set and that the rate has
remained within the user-specified limits.

� Red signifies that a transport rate error is occurring.

� Orange signifies that all of the program’s monitored rates are currently
within the user-set limits but that a rate error has occurred since monitoring
began.
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Automatic Analyses
This section discusses the automatic analyses in the order that they are listed in
the Automatic Analysis Settings window tab. Refer to Table 3–1 for the page on
which each analysis is explained.

In the standard configuration, all analyses on the Automatic Analysis Settings
window tab are selected as shown in the above illustration. If the input stream
contains many errors, the RTA can begin filling the RTA-to-PC buffer and
performance can slow to less than real-time as the software and hardware attempt
to detect, report, and record all errors.

To minimize or eliminate buffer filling or to ignore certain errors, disable one or
more automatic analyses as follows:

1. Select Settings from the Configuration menu.

2. Click the Automatic Analysis tab of the resulting Settings window.

3. Click a check box to clear it and disable the associated analysis or click
Reset All to disable all analyses of the same level (Multiplex, Transport
Packet, or Table Section).

4. Click OK  at the bottom of the Settings window to confirm the changes and
close the window.
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Table 3–1: Automatic analyses in the RTA 

Analysis Page

Absence of Referenced PID Error 3–9

Program Number Not Defined in PAT Error 3–9

Same PID in Elementary Stream and in PMT Error 3–9

Scrambling without CAT Error 3–9

Ghosts Packet Error 3–9

Unsynchronized Packet Error 3–10

Transport Error Indicator 3–10

Null Packet with PUSI Error 3–11

Reserved PID Error 3–11

PID 0x47 Error 3–11

Reserved PID with TSC Error 3–11

PMT PID with TSC Error 3–12

Continuity Counter Error 3–12

PCR/OPCR Flags Error 3–13

Null Packet with ADF Error 3–13

ADF Flag Error 3–13

Maximum Interval Between Consecutive Sections 3–13

Minimum Interval Between Consecutive Sections 3–15

Section Number or Version Number Error 3–15

Table ID Error 3–15

CRC Error 3–16

NOTE. Several Automatic Analysis selections control DVB-MG tests. Do Not
disable any of these automatic analyses if you plan to use DVB-MG tests to
judge DVB compliance of the input stream.
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Error Condition: The time interval between a PID reference in a PAT, CAT, or
PMT and the appearance of that PID in the stream exceeds the value set on the
Statistic Analysis tab of the Settings window.

Associated DVB-MG recommendation: PID_error, 1.6.

How/where an error is reported: In the DVB-MG view and as an error message in
the General Message view.

Additional information: Choose Settings from the RTA Configuration menu to
open the Settings window; click the Statistic Analysis tab to see and change the
intervals.

Error Condition: A PMT program number is not defined in the PAT.

Associated DVB-MG recommendation: None.

How/where an error is reported: As an error message in the General Message
view.

Error Condition: A PMT and an elementary stream are identified with the same
PID.

Associated DVB-MG recommendation: None.

How/where an error is reported: As an error message in the General Message
view.

Error Condition: Packets with non 00 transport_scrambling_control exist in the
stream but no section with table_id 0x01 (a CAT) is found.

Associated DVB-MG recommendation: CAT_error, 2.6.1.

How/where an error is reported: In the DVB-MG view and as an error message in
the General Message view.

Error Condition: A PID (other than one of the defined or reserved values) appears
in the stream but is not referenced in a PMT within 0.5 seconds.

Associated DVB-MG recommendation: Unreferenced_PID, 3.4.

How/where an error is reported: In the DVB-MG view, in the General Message
view, as a Ghost icon in the Hierarchic view, and as a Ghost service/program in
several Statistic view panels.

Absence of Referenced
PID Error

Program Number Not
Defined in PAT Error

Same PID in Elementary
Stream and in PMT Error

Scrambling without CAT
Error

Ghosts Packet Error
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Error Condition: A transport packet header Sync_byte that is not 0x47.

Associated DVB-MG recommendation: Sync_byte_error, 1.2.

How/where an error is reported: In the General Message view, the UNP indicator
on the application window status bar, and the Unsynchro Packets panel of the
Statistic View.

Additional information: If synchronization is lost, no other analyses are possible.

Like the TP Error Indicator panel shown above, the Unsynchro Packets panel
provides a graphical view of Unsynchronized Packet occurrence (UNP). The
vertical units are UNP per 500 ms; the scale is logarithmic to display both very
low and very high rates of error.

The status bar UNP indicator follows the same color conventions as the TEI
indicator.

Error Condition: A transport_error_indicator field (of a transport packet header) is
equal to 1, which indicates that at least one uncorrectable bit error exists in the
associated transport packet.

Associated DVB-MG recommendation: Transport_error, 2.1.

How/where an error is reported: The DVB-MG view, the TEI indicator on the
application window status bar, and the TP Error Indicator panel of the Statistic
View.

Additional information: The TP Error Indicator panel provides a graphical view of
TEI occurrence. The vertical units are TEI per 500 ms; the scale is logarithmic to
display both very low and very high rates of error.

The status bar TEI indicator follows the standard RTA color sequence to signal
errors: gray signifies that the analysis is disabled; green signifies that analysis is
enabled, but that no errors have been detected; red signifies that errors are being

Unsynchronized Packet
Error

Transport Error Indicator
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detected; orange signifies that one or more errors have occurred, but are not
currently detected.

The UNP indicator

The TEI indicator

Error Condition: The payload_unit_start_indicator in a null packet (PID 0x1FFF)
is not 0.

Associated DVB-MG recommendation: None.

How/where an error is reported: As an error message.

Error Condition: A reserved PID is found in the input stream. PIDs must be
0x0000, 0x0001, or within the range of 0x0010 through 0x1FFF; any other PID
is an error.

Associated DVB-MG recommendation: None.

How/where an error is reported: As an error message in the General Message
view.

Error Condition: A packet with PID 0x47 is received.

This is not a violation of the MPEG-2 standard. However, you may want to
detect PID 0x47 since it can lead to troubles during decoding if the decoder
incorrectly interprets the PID as a sync byte.

Associated DVB-MG recommendation: None.

How/where an error is reported: As a syntax error in the appropriate Message
view(s).

Error Condition: A PID 0x0000 (PAT), 0x0001 (CAT), or 0x1FFF (null/stuffing)
packet with a transport_scrambling_control field that does not equal 00.

Associated DVB-MG recommendation: PAT_error, 1.3.3.

How/where an error is reported: An error message in the General Message view
and in the item Message view, if any.

Null Packet with PUSI
Error

Reserved PID Error

PID 0x47 Error

Reserved PID with
TSC Error
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Error Condition: A PMT packet (table_id 0x2) with a transport_scrambling_con-
trol field that does not equal 00. MPEG standards do not allow scrambled PMT.

Associated DVB-MG recommendation: PMT_error, 1.5.2.

How/where an error is reported: In the DVB-MG view, in the general Message
view, and in the PMT Message view, if it is open in the Client window pane.

Error Condition: An incorrectly incremented transport packet continuity_counter.
Except for null packets and in cases of duplicate packets or discontinuities, the
continuity counter of each successive payload-carrying packet of the same PID
must increment by one, from 0x0 to 0xF (modulo 16).

Associated DVB-MG recommendation: Continuity_count_error, 1.4.

How/where an error is reported: The DVB-MG view, the Continuity Counter
panel of the Statistic view, and the appropriate Message view(s).

Additional information: The Continuity Counter panel displays detected errors on
a per-service basis. Refer to Continuity Counter on page 3–55 for an explanation
of this panel.

PMT PID with TSC Error

Continuity Counter Error
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Error Condition: A transport packet adaptation field PCR_flag is set to 0 when
the OPCR_flag is set to 1 (cannot have an OPCR without a PCR).

Associated DVB-MG recommendation: None.

How/where an error is reported: An error message in the appropriate Message
view(s).

Error Condition: There are three error conditions:

� The adaptation_field_control is 00.

� The adaptation_field_control is 10, but the adaptation_field_length is not
equal to 183.

� The adaptation_field_control is 11, but the adaptation_field_length is not in
the range of 0 through 182.

Associated DVB-MG recommendation: None.

How/where an error is reported: As an error message.

Error Condition: A transport packet adaptation_field_control field set to 00,
which is not allowed in the MPEG-2 standard.

Associated DVB-MG recommendation: None.

How/where an error is reported: As a syntax error in the appropriate Message
view(s).

Error Condition: Interval between consecutive table sections exceeds the value set
on the Section Rates Analysis tab of the Settings window.

Associated DVB-MG recommendation: PAT_error, 1.3.1; PMT_error, 1.5.1;
NIT_error, 3.1.2; SI_repetition error, 3.2; SDT_error, 3.5; EIT_error, 3.6.1;
TDT_error, 3.8.1.

How/where an error is reported: In the DVB-MG view, in a Client window
Section Rate view, and in the appropriate Message view(s).

Additional information: Choose Settings from the RTA Configuration menu to
open the Settings window; click the Section Rates Analysis tab to see and
change the intervals.The default Section Rates Analysis settings are consistent

PCR/OPCR Flags Error

Null Packet with ADF
Error

ADF Flag Error

Maximum Interval
Between Consecutive

Sections
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with DVB-MG. Do not change values if you intend to follow DVB-MG
recommendations.

To open a dynamic table section rate view in the Client window pane, select the
Hierarchic view icon of the table, right-click to open the shortcut menu, and then
select View section rate. The lower Section Max Interval graph indicates errors
in red.
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Error Condition: The minimum interval between consecutive table sections is less
than 25 ms.

Associated DVB-MG recommendation: SI_repetition_error, 3.2.

How/where an error is reported: In the DVB-MG view and as an error message in
the appropriate Message views(s).

Error Condition: One or more of the following section and version numbering
errors found in a PSI or SI table section:

� Sections received out of order; for example section number 1 arrives before
section number 0.

� All sections with the same version number do not have the same last section
number.

� The version number is improperly incremented.

� The version number increments before the last section of the previous
version number has been received.

Associated DVB-MG recommendation: None.

How/where an error is reported: In the appropriate Message view(s).

Error Condition: A table_id value that is incompatible with the PID of the (SI
table) packet that contains it.

Table type PID Permissible table_id values

PAT 0x0000 0x00

CAT 0x0001 0x01

NIT 0x0010 0x40, 0x41, 0x72

SDT 0x0011 0x42, 0x46, 0x4A, 0x72

EIT 0x0012 0x4E through 0x6F, 0x72

RST 0x0013 0x71, 0x72

TDT 0x0014 0x70, 0x72

Associated DVB-MG recommendation: PAT_error, 1.3.2; CAT_error, 2.6.2;
SDT_error, 3.6.2; TDT_error, 3.8.2.

How/where an error is reported: In the DVB-MG view and on the appropriate
Message view(s).

Minimum Interval Between
Consecutive Sections

Section Number or
Version Number Error

Table ID Error
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Error Condition: A CRC error in a PSI or SI table.

Associated DVB-MG recommendation: CRC_error, 2.2.

How/where an error is reported: In the DVB-MG view and as a syntax error in the
appropriate Message view(s).

Probes
Real-Time Analyzer probes are user-initiated analyses that you can set to monitor
and analyze certain selected features of the input stream. There are four probe
types; the discussion of each type begins on the indicated page:

� InterSI, page 3–16

� PCR, page 3–18

� PTS/DTS, page 3–20

� Section Syntax, page 3–21

The InterSI probe applies to all SI tables in the stream. The section syntax probe
applies to all sections of a given table, such as the SDT (actual) or the BAT. You
can set the PCR and PTS/DTS probes to monitor the PCRs or time stamps
embedded in one, several, or all individual programs or elementary streams.

You can set and remove probes either through Hierarchic view shortcut menus or
through the Probes List tab of the Settings window.

Setting the InterSI probe activates two types of analysis :

� Intra analysis, which detects problems within PSI or SI tables.

� Inter analysis, which detects problems of coherence between SI tables.

Setting the InterSI Probe. To set/remove the InterSI probe, select a Hierarchic
view icon that represents an SI table (NIT, EIT, SDT), right-click to open the
shortcut menu, and then select InterSI Probe from the menu.

CRC Error

The InterSI Probe
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You can also set the InterSI probe through the Probes List tab of the Settings
window. To open the window, select Settings from the RTA Configuration
menu; refer to Probes List on page 3–88 for more information.

Analyses Within Tables. When the InterSI probe is set, the RTA checks the PMT,
NIT, BAT, EIT and SDT for the presence of mandatory descriptors and checks all
descriptors for compliance with DVB standards.

The RTA also checks the following specific characteristics of the NIT and EIT:

� In the NIT, the transport_stream_id and the network_id must be unique for a
given network_id.

� In the EIT, the field event_id must be unique for a given service_id,
transport_stream_id, and original_network_id.

� If an EIT is of type “schedule,” then the running_status field must be set to
“undefined.”

� If EIT is of type “following,” then the running_status field shall not be set to
“running.”

Analyses Between Tables. When the InterSI probe is set, the RTA monitors the
NIT, SDT, EIT, and BAT for inter-table compatibility and reports errors if the
tables do not satisfy the following conditions:

� The transport_stream_id and original_network_id fields of the NIT should be
referenced in an SDT.

� Each transport_stream_id, original_network_id, service_list_descriptor, and
service_id of the NIT must be present in an SDT.

� The transport_stream_id, and original_network_id fields of the EIT must be
declared in the NIT.

� Each transport_stream_id, original_network_id, service_list_descriptor, and
service_id of the BAT must be present in an SDT.

� There should be an EIT referencing the service_id, transport_stream_id, and
original_network_id fields of the SDT.

� If the EIT_schedule_flag field of the SDT is set to 1, then an EIT schedule
for service_id, transport_stream_id, and original_network_id must be
present.

� If the EIT_schedule_flag of the SDT is set to 0, then an EIT schedule should
not be present for service_id, transport_stream_id, or original_network_id.
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� If the EIT_present_following_flag of the SDT is set to 1, then an EIT
present/following for service_id, transport_stream_id, and original_net-
work_id must be present.

� If the EIT_present_following_flag of the SDT is set to 0, then an EIT
present/following should not be present for service_id, transport_stream_id,
or original_network_id.

InterSI Error Reporting. InterSI probe information and Error messages are
displayed in the General Message view as shown in the following illustration. If
the InterSI probe detects errors within a table, the indicator above the hierarchy
icon of the affected table becomes red; the associated error message(s) also
appear in the Message view of that table (if you double-click the table icon to
open such a view in the Client window pane).

PCR probes monitor the clock references of a selected program for regularity and
precision. When you set a PCR probe in the standard configuration, the RTA
reports a PCR error if the interval between consecutive PCR packets is greater
than 100 ms in MPEG-2 mode or greater than 40 ms in DVB mode, or if the
PCR inaccuracy is greater than +/–500 ns.

The default error limits are consistent with DVB-MG recommendations. You can
change the limits if necessary through the Configuration menu.

PCR Probes
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Setting PCR Probes. You can set a PCR probe either through the Hierarchic view
or through the Configuration menu:

� To set a PCR probe through the Hierarchic view, select the PMT icon that
represents the program of interest, right-click to open a shortcut menu, and
then select PCR Probe or View PCR Analysis.

When you select View PCR Analysis, a PCR Analysis view, as described on
page 3–64, opens and the probe is set automatically. To remove the PCR
probe, select PCR Probe a second time from the PMT shortcut menu.

� To set a PCR probe through the Configuration menu, open the menu and
select Settings. Then click the Probes List tab on the resulting Settings
window. Click PMT in the Table type list; enter the hexadecimal program
number in the Program Number box or select ALL ; click PCR in the
Probe Type box; click Add; and finally click OK on the bottom of the
window. Refer to Probes List on page 3–88 for more information.

When you select ALL  on the Probes List tab, the RTA monitors all PCRs in the
input stream. If you enter a single program or activate the probe through the
Hierarchic view, the RTA monitors the clocks used by that program.

PCR Probe Thresholds. You can change the PCR probe error thresholds through
the Configuration menu with the following steps:

1. Open the Configuration menu and click Settings.

2. Select the PCR Analysis tab of the resulting Settings window.

3. Enter the desired values in the Interval  and Precision fields.

4. Click OK  to accept the new values and close the Settings window.

Refer to PCR Analysis on page 3–87 for more information about the PCR
Analysis settings tab.

Settling Filter. The Settling Filter, which improves the accuracy of PCR jitter
analysis, must have at least 60 seconds of data before before the RTA can detect
and report PCR jitter errors. Wait 60 seconds after setting a PCR probe to judge
the PCR jitter performance or compliance.

PCR Error Reporting. When a PCR error occurs, the colored indicator above the
affected Hierarchic view PMT icon turns red and an error message appears in the
General Message view. The message also appears on the PMT Message view if it
is open in the Client window pane.
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The RTA also indicates PCR errors in the DVB-MG view and the PCR Analysis
view. The application signals errors in the PCR analysis view by changing the
graph plot line and the corresponding Min or Max readout text from blue to red.

PCR Analysis Accuracy. Real-Time Analyzer hardware considerations limit the
accuracy of PCR analysis. The following table summarizes the accuracy possible
for jitter parameters displayed in the PCR Analysis view.

Table 3–2: PCR analysis accuracy 

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Characteristic ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Description
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Frequency Offset readout ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Accuracy ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

�3.0 ppm
ÁÁ
ÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Drift, typical
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

�1 ppm per year
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁJitter readout and graphical display accuracy, typical

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁ
ÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Parallel input
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

�30 ns peak

ÁÁ
ÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ASI input ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

�60 ns peak

PTS/DTS probes monitor the time stamps of selected elementary streams for
compliance with the DVB-MG recommended interval of no more than 700 ms
between consecutive PES packets with non zero PTS/DTS flags. You can set
PTS/DTS probes only on unscrambled elementary streams.

PTS/DTS Probes
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Setting PTS/DTS Probes. You can set PTS/DTS probes either through the
Hierarchic view or through the configuration menu.

� To set a PTS/DTS probe through the Hierarchic view, select the audio or
video elementary stream icon that represents the stream of interest, right-
click to open a shortcut menu, and then select PTS/DTS Probe or View
PTS/DTS Analysis.

When you select View PTS/DTS Analysis, a PTS/DTS Analysis view—as
described on page 3–63—opens and the probe is set automatically. To
remove the PTS/DTS probe, again select PTS/DTS Probe from the
elementary stream shortcut menu.

� To set a PTS/DTS probe through the Configuration menu, open the menu
and select Settings. Then click the Probes List tab on the resulting Settings
window. Click Elementary Stream in the Table type list; enter the hexadeci-
mal PID in the PID box or select ALL ; click Add; and finally click OK on
the bottom of the window. Refer to Probes List on page 3–88 for more
information.

PTS/DTS Error Reporting. When a PTS/DTS error occurs, the colored indicator
above the affected Hierarchic view elementary stream icon turns red and an error
message appears in the General Message view. The message also appears on the
elementary stream Message view if it is open in the Client window pane.

The RTA also indicates PTS/DTS errors in the DVB-MG view and the PTS/DTS
Analysis view. The application signals errors in the analysis view by changing
the graph plot line and the corresponding Max readout text from blue to red.

Set a section syntax probe to perform a complete analysis of every field in all
sections of the selected table type.

Setting a Section Syntax Probe. You can set section probes either through the
Hierarchic view or through the configuration menu.

� To set a section probe through the Hierarchic view, select the icon that
represents the table of interest, right-click to open a shortcut menu, and then

Section Syntax Probes
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select Section Probe or (PAT, PMT, or CAT ) Section Probe (the first
command on the shortcut menu).

You can also select View section analysis to open a Section Analysis view
of the table as described on page 3–59. Once the view opens, the syntax
probe is automatically set on the selected table type.

� To set a section syntax probe through the Configuration menu, open the
menu and select Settings. Then click the Probes List tab on the resulting
Settings window. Click any table entry in the Table type list; click Syntax
in the Probe Type list; click Add; and finally click OK on the bottom of the
window. Refer to Probes List on page 3–88 for more information.

Syntax Error Reporting. When the RTA detects a section syntax error, the error
indicator above the Hierarchic view icon turns red and an error message appears
in the General Message view. You can also double-click the Hierarchic view icon
to open a Message view particular to the affected table.

The RTA also notes the presence and nature of each section syntax error in the
section analysis view, as explained under Section Analysis View on page 3–59.
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User Interface

The Real-Time Analyzer (RTA) application window shown below fills the entire
screen when you start the program.

Hierarchic
window

Client
window

General
message
window

Menu bar

Toolbar

Status bar

Title bar

This section describes and explains the following features of the RTA application
window:

� The title bar (page 3–25)

� The menu bar, which provides access to the various RTA command menus
(page 3–25)

� The toolbar, which contains graphical command buttons for many of the
most-used menu commands (page 3–30)

� The status bar, which displays help statements and useful information about
the analyzed stream (page 3–32)

� The Hierarchic window pane, which, during monitoring/analysis, contains
the Hierarchic view (page 3–33)
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� The General Message window pane (page 3–43)

� The Client window pane, which can contain one or more subordinate views
(page 3–48; the section also discusses the subordinate views in detail)

Application Window Conventions
Wherever possible, the RTA follows Windows NT 4.0/Windows 95 user
interface conventions.

NOTE. This manual is written assuming a basic level of familiarity with the
Windows 95 or the Windows NT 4.0 operating system. If you are not familiar
with either operating system, please review the Windows NT documentation that
accompanied your instrument.

As you use the RTA, you may find it useful to change the relative sizes of the
Hierarchic, Client, and General Message window panes, depending on the
information that is most important at a given time. To change the relative widths
of the Hierarchic and Client panes, position the pointer over the split bar (the
border between the two panes); the pointer changes from an arrow to a special
shape ( ). Press the mouse button down and drag the border left or right to
decrease or increase the width of the Hierarchic pane.

Default window widths Split bar moved to the right to show more of the hierarchy

You can change the height of all three panes by dragging the split bar that
separates the Hierarchic and Client windows from the General Message window.

You can also maximize the height of the Hierarchic and Client window panes by
changing the General Message window into a Client window view. Refer to
Toggle Docking on page 3–48 for instructions.
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Title Bar
In addition to identifying the Real-Time Analyzer application, the title bar
indicates which of the three window panes is selected and the contents or subject
of the current Client view.

The Hierarchic pane is selected and the DVB-MG view is the current Client view:

The General Messages pane is selected and the DVB-MG view is the current Client view:

The Client pane is selected and the DVB-MG view is the current Client view:

The Client pane is selected and EMM, PID 0x20, is the subject of the current Client view:

Because the contents of the selected pane are printed, it is important to know
which pane is selected before choosing Print  from the View menu. To select a
pane, click anywhere within the pane.

Menu Bar
The menu bar contains the six RTA command menus.

� Configuration. The Configuration menu contains commands for managing
program settings and configurations and for exiting the RTA application.

� View. The View menu contains commands for managing the different RTA
views.

� Analysis. The Analysis menu contains commands to start and stop input
stream analysis.

� Data storage. The Data Storage menu contains commands to start and stop
input stream storage (on the MTS 215 only).

� Window. The Window menu contains commands for managing the various
windows within the RTA Client window.

� Help. The Help menu provides access to RTA online help and version
information.
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The Active view menu, denoted with various view symbols, appears on the left
end of the menu bar when a view is maximized in the Client window. The pie
chart symbol in the menu bar shown above indicates that the Statistic view is
active in the Client window.

The Configuration menu contains commands for managing program settings and
configurations and for exiting the RTA application (because there is no File
menu). Refer to Configuration, beginning on page 3–67, for more information.

Use To

Settings Open the Settings window

Load Restore a previously-saved configuration

Save as Save the current configuration

Restore standard Restore default settings only when analysis is stopped

Exit Quit the Real-Time Analyzer application

Configuration Menu
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Use the View menu commands to control the information displayed in the RTA
application window.

Use To

Freeze views Suspend (freeze) window updates while analysis continues. Freezing
the views allows you to examine or capture transitory information (that
is likely to soon disappear from the display) and to find and examine
error messages that have scrolled off the top of a message window.

Reset past errors Acknowledge all previously-detected errors, reset all error counters to
zero, and restore all orange-colored indicators to their original color.

Message[s] view Open the Message view or select the Message view and place it in
front of all other views if necessary.

Statistic view Open the Statistic view or select the Statistic view and place it in front
of all other views, if necessary.

DVB-MG view Open a (detailed or monitor) DVB-MG view or select the DVB-MG
view and place it in front of all other views, if necessary.

Toolbar Toggle the presence of the Toolbar (Command buttons) in the RTA
application window. A check mark precedes the command when the
Toolbar is present.

Status bar Toggle the presence of the Status bar in the RTA application window.
A check mark precedes the command when the Status bar is present.

Print Print the current window or window pane.

Print Setup To configure the printer.

View Menu
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The Analysis menu contains commands for starting and stopping input stream
analysis. You may find it more convenient to use the command button equiva-
lents on the toolbar.

Use To

Start Begin analyzing the input stream

Stop Stop input stream analysis

The Data Storage menu is only applicable to MTS 215 instruments, which are
equipped with the Data Store system.

Use To

Start Begin saving the input stream to the data store disks (MTS 215 only)

Stop Stop data capture

Analysis Menu

Data Storage Menu
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The Window menu contains commands for managing the various windows
within the RTA Client window.

Use To

Cascade Arrange windows in the Client view in an overlapping upper-left to
lower-right cascade. The active window is on the lower right.

Tile horizontally Arrange Client view windows as non-overlapping tiles that stretch from
left to right across the Client window.

Tile vertically Arrange Client view windows as non-overlapping tiles that stretch from
from the top of the Client window to the bottom.

Arrange icons Arrange minimized view icons along the bottom of the Client window.

Restore standard Restore the default RTA window arrangement.

(List of open windows) Select the window to be shown in front of all other windows.

The Help menu provides access to online help and version information.

Use To

Help Topics Open the RTA Help window

About RTA Display RTA version and copyright information

Window Menu

Help Menu
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The active view menu pertains to the top view in the Client window when the
Client views are maximized; the menu contains standard Windows NT window-
management commands. Only four of the commands are available.

Use To

Restore Change all open Client views to windows or icons within the Client
window, depending on the last state of each window. This command is
equivalent to clicking on the Restore button above the upper right
corner of the Client window. The active view menu disappears from
the Menu bar when you select this command.

Minimize To minimize all open Client views to icons within the Client window.
The active view menu disappears from the Menu bar when you select
this command.

Close Close the current active (top) Client view.

Next Select the next Client view. This command is equivalent to clicking the
view tab to the right of the tab attached to the currently active view.

The Toolbar
The toolbar provides shortcut buttons for many of the most often used menu
commands. Click the button to choose the corresponding command. You can
toggle the toolbar on and off with the View menu Toolbar command.

Icon Name Function
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Start Analysis
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Begin analysis; equivalent to the Start command on the Analysis
menu.

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Stop Analysis ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

End analysis; equivalent to the Stop command on the Analysis
menu.

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Freeze
(or Pause)

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Suspend all window updates but continue monitoring incoming
stream; equivalent to the Freeze views command on the View
menu.

Active View Menu
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Icon FunctionName

Start Data Store
(MTS 215 only)

Begin capturing the incoming stream onto the data store disks or
pass the input stream through to the parallel output; equivalent to
the Start command on the Data Storage menu.

Stop Data Store
(MTS 215 only)

Stop capturing the incoming stream; equivalent to the Stop
command on the Data Storage menu.

Message view Open or select the Message view; equivalent to the Messages
view command on the View menu.

Statistic view Open or select the Statistic view; equivalent to the Statistic view
command on the View menu.

DVB-MG view Open or select the DVB-MG view; equivalent to the DVB-MG view
command on the View menu.

Restore
standard

Equivalent to the Restore standard command on the Window
menu.

You can relocate the toolbar elsewhere within the RTA application window as
shown in the following sequence by clicking the gray area between two
command buttons, dragging the bar to the new location, and releasing the mouse
button.
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The Status Bar

By default, the status bar appears at the bottom of the RTA application window.
You can toggle the status bar on and off with the View menu Status bar
command.

The Status bar shows the following information:

� Help and status messages for menu and toolbar commands. For example,
when you select the Freeze views command from the View menu, the word
PAUSE appears on the left end of the status bar, as shown in the following
capture.

� The status (percent usage) of the PC-to-RTA communication buffer.

� The number of bytes (188 or 204) in the input stream transport packets.

� The global bit-rate of the input stream.

� Presence of priority one (MG1), priority two (MG2), and priority three
(MG3) DVB-MG errors. If there is no error, a green sphere icon is displayed;
when an error occurs, the sphere becomes red. If the error stops occurring,
the icon becomes orange to indicate that at least one error has been detected
in the past.

� Status of the TEI (Transport Error Indicator). The error indicator icon
follows the same color conventions as the MG1, 2, and 3 indicators. The
icon is gray when TEI analysis is disabled.

� State of the UNP (Unsynchronized Packet). The error indicator icon follows
the same color conventions as the MG1, 2, and 3 indicators. The icon is gray
when UNP analysis is disabled.

� Running state of the data storage (MTS 215 only). If the input stream is
being saved on the data store disks, a cassette tape icon alternates with the
abbreviation “REC.”

� Running state of the analysis. If the stream is currently under analysis, the
world globe icon at the right end of the bar appears to rotate.
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The Hierarchic View
The Hierarchic view uses icons to show the interrelationship of stream compo-
nents and displays additional text information about each component. The
Hierarchic view can be the starting point for several types of analysis. The fully
expanded Hierarchic view of a simple DVB transport stream might resemble the
hierarchy below (you must enlarge the Hierarchy window pane to see this much
of the view at one time).

Level 1

Level 2

Level 3

Level 4
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The colored indicator rectangles above each icon highlight stream items in which
errors have been detected. Refer to Error Indicators on page 3–35.

Table 3–3 lists and explains the base icons used in the Hierarchic view. These
icons normally appear in color on the RTA display except when the correspond-
ing item is referenced in a table but has not yet appeared in the stream. Icons for
these referenced but absent items remain grayed until the item appears in the
input stream.

NOTE. Grayed icons represent items that have been referenced, but not yet
detected by the RTA. Ghost icons represent items that have been detected by the
RTA but are not referred to in any table.

An error indicator appears above each icon in the hierarchy. In addition, the PCR
clocks and scrambling symbols are superimposed on icons when appropriate.

Table 3–3: Base icons used in the RTA Hierarchic view 

Icon Element typeÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Transport stream

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

PAT (Program Allocation Table) or 
CAT (Conditional Access Table)

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

PMT (Program Map Table)

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Another PSI (MPEG-2) or SI (DVB) table, such as NIT, SDT, EIT, RST, or TDT,
or a private table

GHOST. A ghost indicates one or more transport packets identified with a PID
that is not referenced in an appropriate table.

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Video elementary stream

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Audio elementary stream

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Data stream

Hierarchic View Icons
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Table 3–3: Base icons used in the RTA Hierarchic view (Cont.)

Icon Element type

ECM (Entitlement Control Message) table

EMM (Entitlement Management Message) table

Error Indicators. The colored rectangles that appear over each icon in the
Hierarchic view are error indicators; the error indicator color conveys informa-
tion about the monitoring and error status of the stream element.

Error indicator

A gray indicator signifies that no user-specified probes that affect the item are set
and that the automatic tests have detected no errors.

A green indicator signifies that at least one user probe is set and that no error has
been detected.

A red indicator signifies that at least one error has been detected and is still
pending.

An orange indicator signifies that at least one error has been detected in the past
but is no longer occurring.

When an error occurs at a given level, the indicator changes its color not only for
the considered item, but also for all parent items. For example, if an error occurs
for an elementary stream, both the program icon and the multiplex icon captions
will change color. This is especially useful when the RTA detects errors when a
“+” sign next to the icon indicates that the tree is collapsed.

PCR Clock Symbol. A PCR clock ( ) symbol is added to the upper-right corner
of stream icons to indicate streams that carry PCR clocks.
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The TS railcar and clock icon represents PCR clocks in an independent stream
(that is, transport packets containing PCRs).

Scrambling Symbol. A padlock symbol ( ) is added to the lower-left corner of

stream icons to signify the streams that are scrambled.

Information about an item appears to the right of its icon. The information
depends on the type of item as shown in the following hierarchy excerpts.

Network name, extracted from
the network_name_descriptor

field of the NIT

Frequency, extracted from the
satellite_delivery_system_descriptor

of the NIT

transport_stream_id,
extracted from the PAT

Polarization, extracted from the
satellite_delivery_system_descriptor
of the NIT
LH = linear horizontal
LV = linear vertical
CL = circular left
CR = circular right

Total number of
errors detected in
the input stream

Number of programs
defined in the PAT

Item PID

Table section rate and
maximum interval between

sections (toggled on/off
with the F6 function key)

Item Information
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Program number

Service name

Number of item errors
detected by the RTA

Network ID 
(DVB mode only)

Service ID and name

Table 3–4 summarizes the affects of mouse and keyboard actions that change the
appearance of the Hierarchic view and reveal (or hide) additional information
about the input stream.

Table 3–4: RTA mouse and keyboard actions 
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁMouse action

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁKeyboard action

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁAffect on HierarchyÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Left-click on a Hierarchic
view icon

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Select the icon

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Right-click on an icon
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Display a shortcut menu for the
hierarchy item. Refer to Short-
cut Menus, on page 3–41.

Using the Hierarchic View
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Table 3–4: RTA mouse and keyboard actions (Cont.)

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Affect on HierarchyÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Keyboard actionÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Mouse action
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Double-click on an  icon
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Open an item Message view in
the Client window.

Click the + box next to an
icon

Press + on the numeric keypad Display one sub level (if any)
below the selected icon.

Click the – box next to an
icon

Press – on the numeric keypad Collapse the sub level below
the selected icon (will not
override the F7 through F10
selections explained below).

Press * on the numeric keypad Open all sublevels below the
selected icon.

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Press the up or down arrow keyÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Select the icon immediately
above or below the currently-
selected icon.

Press F2 Toggle numeric display between
hexadecimal and decimal base
(for example, 0x00C1 ↔ 193).

Press F3 Freeze/unfreeze view updates.

Press F4 Reset all past errors; all orange
error indicators become green
or gray.

Press F6 Toggle section rate display.

Press F7 Show first-level hierarchy items
only.

Press F8 Show hierarchy items in the first
and second levels only.

Press F9 Show hierarchy items in the first
three levels.

Press F10 Show all hierarchy items in the
first four levels. There will be no
“+” signs to the left of hierarchy
icons.
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Press the F7 function key to
hide all but the top-level
hierarchy items.

Press the F8 function key to
show only the top two
hierarchy levels.

Press the F10 function key to
show all items in the hierarchy.

In addition to the error indicator at the top of each Hierarchic view icon, the
number of errors detected for the item or for sublevels of the item are listed in
the text entry to the right of the icon.

For example, the following Hierarchic view shows that a total of 104 errors have
been detected since monitoring began (or since the last error reset).

There have been three errors under the PAT:

One in the PMT of PID 0x502

One in the PMT of PID 0x503

One in the PMT of PID 0x506

Error Reporting in the
Hierarchic View



User Interface

3–40 Real-Time Analyzer User Manual

There has been one error in the CAT and 100 errors under the CAT, in the EMM
of PID 0x00C1.

Number of errors detected
in the levels below the
current hierarchy item.

Number of errors detected
in this hierarchy item
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Every active hierarchy item that is represented by a color icon has a shortcut
menu that enables you to learn more about a selected item, reset errors,
and—depending on the item—set and clear probes directly from the Hierarchic
view. Right-click on an icon to open the shortcut menu; then left-click on a menu
command to select it.

The shortcut menus associated with the various stream items are shown in the
following illustrations and explained in Table 3–5.

Transport Stream

PMT DVB-SI Table Elementary Stream

PAT MPEG NIT Private Section

ECM EMM Ghost

Shortcut Menus
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Notice that grayed menu items are unavailable and cannot be selected. Items are
unavailable for a number of reasons:

� PTS/DTS probes cannot be set on scrambled elementary streams.

� PTS/DTS probes cannot be removed through the shortcut menu when the
probe has been set on all elementary streams through the Configuration
menu.

� PCR probes cannot be removed when the probe has been set on all programs
through the Configuration menu.

� Reset past errors is unavailable when no errors have been detected.

Table 3–5: Hierarchic view shortcut menu commands 

Select To

(XXX) Section probe Set or clear the probe for the selected section type; refer to
Section Syntax Probes on page 3–21.

View section analysis Open a section analysis view of the selected table; refer to
Section Analysis View on page 3–59.

View section rate Open a section rate view for the selected table; refer to Section
Rate View on page 3–62.

View messages Open an item message window in the RTA Client window pane
or bring an already-opened message window to the front.
Equivalent to double-clicking on the icon.

Transport rate interval Set transport rate error thresholds for the selected item; refer to
Transport Rate Analysis on page 3–1.

Reset past errors Clear error history and reset error counter to zero. Enabled only
when the error indicator is orange (indicating a past error, but
no current errors).

PCR probe
(PMT shortcut menu)

Set or remove a PCR probe on the selected program; refer to
PCR Probes on page 3–18.

View PCR analysis
(PMT shortcut menu)

Open a PCR analysis window for this program; refer to PCR
Analysis View on page 3–64.

InterSI probe
(DVB-SI shortcut menus)

Set or remove the InterSI probe; refer to InterSI Probe on
page 3–16.

PTS/DTS probe
(Elementary Streams)

Set or remove the PTS/DTS probe on the selected elementary
stream; refer to PTS/DTS Probes on page 3–20.

View PTS/DTS analysis
(Elementary Streams)

Open a PTS/DTS analysis window for this elementary stream;
refer to PTS/DTS Analysis View on page 3–63.
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The Message Window and Message Views
The Real-Time Analyzer displays information about the input stream, stream
components, and detected errors in Message windows and Message views. By
default, the General Message view, which displays all messages resulting from
stream monitoring and analysis, appears in a separate window pane at the bottom
of the RTA application window.

The RTA can also create additional Message views that are specific to a given
stream item. To open an item Message view in the Client window pane, either
double-click on the Hierarchic view icon or select View messages from the icon
shortcut menu (refer to Shortcut Menus on page 3–41).

The Message views can contain four types of messages, depending on configura-
tion choices made in the Message Views settings panel (refer to Messages View
on page 3–76 for configuration information):

� Information messages, which note significant events such as the establish-
ment and loss of synchronization, updates of most PSI and SI tables, and
error disappearance

� Error messages, with which the RTA attempts to report all errors detected in
the input stream

Message Types
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� TDT and TOT update messages

� EMM update messages

Some messages are highlighted by a colored indicator sphere at the left end of
the display. A a blue indicator precedes “Synchronization detected” messages; a
red indicator precedes error messages; and a yellow indicator precedes “Loss of
Synchro[nization]” messages.

The messages that appear in the Message views are determined by your view
configuration choices, all RTA settings that affect error detection, and the
contents of the input stream. For example, imagine that you configure the RTA
to display information messages only and then (through the Transport Rate
Analysis settings panel) set a low transport rate error threshold for a selected
PID. Then, if the transport rate drops momentarily below the error threshold, you
will not see an error message when the transport rate is below the threshold, but
you will be informed when the error has disappeared.

In the standard configuration, Message views can contain up to 1000 message
lines. To see earlier messages that have scrolled off the top of the view, use the
vertical scroll box and arrows to locate the message. If the RTA configuration
and input stream contents result in frequent messages, you may have to first

press F3 or click the toolbar Pause ( ) button to suspend window updates. When
more than 1000 messages are received, the earliest messages drop off the top of
the list to make room for the latest messages at the bottom.

Because each Message view line represents a single message, the entire text
often does not fit in the available display space.

To see more of a message, drag the column border (in the window heading,
between the Messages column and the Event ID column) to the right.

To make the column width fit the longest message, double-click the border; then
you may have to drag the horizontal scoll box to the right to read the entire
message.

Reading Messages
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When the RTA is set to log messages to the Windows NT Event Viewer (as it is
in the standard configuration), you can double-click on a message to open a
Detail of Message window.

Notice that a single Message view line can represent several Event Viewer
entries.

Select Print  from the View menu (or press CTRL+P) to print some or all of the
messages in the current message window. It is good practice to choose Print
Preview before printing from the RTA to verify that you have selected the
correct window and to discover which pages contain the messages you are
interested in. In the standard configuration, a Message view can contain up to
1000 message lines, which, when printed, will occupy more than 40 letter-sized
pages.

The RTA can save message details in the Windows NT Event Viewer Applica-
tion log. This gives you the opportunity to save a permanent record of RTA
events which would otherwise be lost when you pause window updates (Freeze
views in the View menu), begin another analysis session, or exit the application.

Turn Event Viewer logging on or off through the Settings command on the RTA
configuration menu; the Event viewer selection is on the General panel of the
resulting Settings window.

Printing Messages

Messages and the
Event Viewer
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When you open a Detail of Message window from within a Message view, you
are accessing the Event Viewer Application log. To access the log directly, start
the Event Viewer application through the Windows NT Start menu (select
Programs, Administrative Tools (Common), Event Viewer). When the Event
Viewer window opens,  select Application  from the Log menu.

The Application Log can contain hundreds of entries; use the vertical scroll bar
and arrows to see entries that will not fit in the window. If the RTA is running,
press F5 occasionally to refresh the view. To open an Event Detail window,
double-click on a log entry.

You can save the current contents of the Application Log to a file for later use,
you can clear the log to make room for more entries, you can change the log size,
and you can specify how the Event Viewer acts when the log is full. Refer to the
Windows NT documentation (or the Event Viewer online help) for more
information.
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NOTE. For best results, do not select any Event Viewer log wrapping setting
other than Overwrite Events as Needed. The RTA may freeze if the application
event log fills to capacity during stream analysis. Choose Log Settings from the
Log menu of the Event Viewer to verify the current log wrapping option and to
change the size of the application event log, if necessary.

The Message view shortcut menu appears when you right-click within a Message
view or window. The three commands as shown below are Clear, Toggle
Docking, and Close.

Clear. Select the Clear command to erase all messages from the window. This
command does not reset past errors or suspend window and view updated. New
messages appear in the window as they are generated by the RTA.

Close. Select the Close command to close the general message window. All
messages are erased. You can later select the Messages view command on the
View menu to open a new General Message window.

The Message View
Shortcut Menu
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Toggle Docking. Select the Toggle Docking command to toggle the position of
the General Message window between the default position, at the bottom of the
application window, and the alternate position, within the Client window.

The Client Window Pane
The Client window pane occupies the upper-right portion of the default RTA
application window. Immediately after you start analysis, the Client window
contains the maximized Statistic view as shown the left side of the above
illustration.

You can also open several different stream analysis results views in the Client
window. This section describes the following client views; the descriptions begin
on the indicated page:

� Statistic view; page 3–50

� DVB-MG view; page 3–57

� Section analysis view; page 3–59

� Section rate view; page 3–62

� PTS/DTS analysis view; page 3–63

� PCR analysis view; page 3–64

You can also open hierarchy-item Message views in the Client window; for
information, refer to The Message Window and Message Views beginning on
page 3–43.
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Normally, the Client views are maximized. That means that each view occupies
the entire Client window. If more than one view is open at a time, you can switch
among them by clicking the appropriate view tab at the bottom of the Client
window.

Statistic view tab PCR analysis view tab

Sizing (Minimize, Restore, and Close) buttons appear on the right end of the
menu bar when the Client windows are maximized.

Client view
sizing buttons

� Click the Close button ( ) to close the top (currently selected) view.

Client Window Features
and Conventions
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NOTE. Closing a window clears all existing information. Unless you are logging
messages to the Event Viewer, all information in a Client view is lost when you
close the view.

� Click the Minimize button ( ) to reduce the top view to an icon within the
Client window and change all other Client views to windows or icons within
the Client window, depending on their previous size. Each window and icon
has its own sizing buttons; the sizing buttons disappear from the menu bar.

� Click the Restore button ( ) to reduce all client views to windows or icons
within the Client window, depending on their previous status, if any. Again,
the sizing buttons disappear from the menu bar because each icon and
window has its own sizing buttons.

To simultaneously maximize the Statistic view and close other client views,
select Restore standard from the Window menu or click the Restore Standard
views toolbar button.

The Statistic view is actually a collection of five different tabbed views or panels
that display data about the input stream and the programs carried in the stream.
One panel is displayed at a time; select the page by clicking on the correspond-
ing tab on the bottom of the view window.

The five Statistic view
panel tabs

This section describes the following Statistic view panels; the descriptions begin
on the indicated page:

� Program Alloc(ation); page 3–52

� PID Alloc(ation); page 3–53

� Continuity Counter; page 3–55

The Statistic View
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� TP (Transport Packet) Error Indicator; page 3–55

� Unsynchro(nized) Packets; page 3–56

Statistic View Features and Conventions. 

The Program Allocation panel of the Statistic view appears in the Client window
immediately after you begin input stream analysis.

When the view first opens, most tabs are hidden by the horizontal scroll bar. You
can click the scroll arrows to reveal the remaining tabs, or you can click the thin
split box and drag to the right to shorten the scroll bar.

This is the original tab and scrollbar configuration:

Scroll arrows Split box

This is how it looks when the scrollbar is shortened:
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Program Allocation. The Program Alloc panel shows the bandwidth allocation of
the input multiplex. The yellow slice of the pie chart represents PSI/SI informa-
tion; each remaining colored slice represents a program, null packets, or
unreferenced (ghost) packets. The pie chart and accompanying color-coded list
provide both a graphic and numeric report of bandwidth usage.

Service or program name

Portion of the input stream
used by the service or program

Transport rate of the
service or program

Double-click on a slice of the pie chart to switch to the PID allocation panel with
the corresponding program already selected. The PID allocation panel is
described next.
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PID Allocation. The PID Alloc panel gives a more detailed, program-level view of
input stream bandwidth allocation. Instantaneous, previous maximum, and
previous minimum multiplex rates are shown by PID for the selected program.

Select a program by clicking the corresponding button on the left edge of the
PID Allocation panel or by double-clicking the program slice in the Program
Allocation view. Each program button has a round error indicator “light” that
shows the status of any transport rate probe that is set. Click Reset past errors
(in the upper-left corner of window) to reset previously-detected transport rate
errors. Refer to Transport Rate Analysis on page 3–1 for complete information.

The right portion of the PID Allocation panel shows transport rate activity for
the entire program and for its constituent parts. Use the vertical scroll bar, if
necessary, to reveal the remaining parts of the program.
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In the panel shown above, the program CHANNEL 1 has an instantaneous
transport rate of 5.759 Mbits/s and has been between 5.750 and 5.768 Mbits/s.
The PID 0x121 video stream has an instantaneous rate of 4.619 Mbits/s, has
ranged from 4.613 to 4.622 Mbits/s, and represents 80.20 % of the program.

Rate bar

Outline bar length depends on the portion
of the program that is used by this PID

You can right-click on the PID list to set transport rate error limits. When PID
transport rate limits are set, limit and error data are also shown; refer to
Transport Rate Analysis on page 3–1 for more information.
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Continuity Counter. The Continuity Counter panel shows the results of automatic
monitoring (per the DVB measurement guidelines, ETR 290) for each PID in the
selected program or service. The data are displayed PID-by-PID, similar to the
PID Allocation view.

Select a program by clicking the corresponding button on the left edge of the
panel. Each program button has a round error indicator light that shows the
presence or absence of continuity counter errors in that program; the right
portion of the panel shows the error status of each individual PID in the program.

� A Green light indicates that there is no continuity counter error.

� A Red light indicates that at least one continuity counter error has occurred
in the last second.

� An Orange light indicates that at least one continuity counter error has
occurred in the past. The exact number of errors is shown under the light.

Click Reset past errors (in the upper-left corner of window) to reset all
previously-detected continuity counter errors (all orange lights become green).

Transport Packet Error Indicators. The TP Error Indicator panel reports the results
of the automatic transport error indicator (TEI) monitoring per ETR 290. The
RTA checks the transport_error_indicator field of every transport packet header
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and counts the number of packets with this bit-field set to 1 every 500 ms. The
Transport Packet Error Indicator panel displays the results in graphical form.

The horizontal (time) scale of the graph is linear. The vertical (errors/500 ms)
scale is logarithmic to show both very low and very high error rates.

Unsynchronized Packets. The Unsynchro Packets panel reports the results of
the automatic sync byte monitoring per ETR 290. The RTA checks the sync_byte
field of every transport packet header and counts the number of packets with
incorrect values every 500 ms. The Unsynchronized Packets panel displays the
results in the same graphical format as the transport error indicator panel: The
number of packets with sync_byte other than 0x47 is counted every 500 ms and
plotted on a graph with a logarithmic vertical scale.
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The two DVB-MG views provide an at-a-glance report of all DVB-MG2

recommended tests performed by the RTA.

To open a DVB-MG view, point to DVB-MG view on the View menu and then
click either Detailed or Monitor . Or click the DVB-MG view toolbar button to
quickly open the DVB-MG Monitor view.

In either DVB-MG view, test numbers are those used in the DVB measurement
guidelines, ETR 290. A colored indicator light shows the status of each test. The
colors are consistent with other RTA indicators:

� Gray signifies that the RTA is not currently performing the test.

A test is not performed for one of three reasons: the user probe is not set; the
test is disabled through the RTA Configuration menu; or the input stream
does not contain the applicable table (MPEG-2 streams, for example, do not
contain SI tables; therefore, tests 3.2 through 3.8 cannot be performed).

� Green signifies that the test is running and that no errors have been detected.

� Red signifies that at least one error is occurring.

� Orange signifies that at least one error occurred in the past.

2 DVB-MG is the DVB consortium working group that is responsible for recommending measurements and controls to be
performed on all the elements of a digital television chain. See Appendix A: DVB-MG Measurements for additional
information about the DVB-MG recommendations and tests.

The DVB-MG View
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You can  double-click on a red or orange indicator to open a message view that
displays the error messages that pertain to that particular DVB-MG error
condition.

The DVB-MG Detailed View. In the DVB-MG Detailed view, shown on the
previous page, three columns list the tests defined in the DVB-MG recommenda-
tions by name and reveal additional information about test thresholds and
affected stream items.

Tests 1.3.1, 1.5.1, 3.1.2, 3.5.1, 3.6.1, and 3.8.1 use error criteria that can be
changed on the Section Rates Analysis tab of the Settings window. The current
values are displayed in gray on the DVB-MG Detailed view.

Maximum NIT section interval
(DVB-MG 3.1.2 error threshold)

Maximum SDT section interval
(DVB-MG 3.5.1 error threshold)

Maximum EIY section interval
(DVB-MG 3.6.1 error threshold)

Tests 2.3, 2.4, and 2.5 (PCR and PTS/DTS probes) are not automatic and are
performed only on user-selected PMTs and elementary streams. Therefore, the
detailed view shows how many of PMTs and elementary streams (ES) in the
input stream have been selected for monitoring.

Monitored PMTs/PMTs in stream

Monitored ES/ES in stream

Click Reset past errors, at the bottom of the first column, to reset all previously
detected DVB-MG errors (all orange lights become green).
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The DVB-MG Monitor View. The DVB-MG Monitor view is a simplified version of
the detail view. It is especially useful when you have reduced all client views to
windows because it leaves the greatest possible Client window area free for other
views. Click the magnifying glass icon at the bottom of the monitor view to open
a detailed view.

As in the detailed DVB-MG view, double-clicking an orange or red error
indicator opens a message view that contains messages pertaining to the error.

The Section analysis view provides a hierarchic and field-by-field view of the
selected table section.

In the left sub-view hierarchy, related fields are grouped and shown as folders
and other icons. With some table types you can expand and collapse the

Section Analysis View
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hierarchy as you would a Windows NT Explorer directory hierarchy. Click a
hierarchy icon to show the contents of the represented item in the right sub-view.
You can also double-click the same icon in the right sub-view to show the same
information.

Opening a Section Analysis View. To open a section analysis view, select View
section analysis from the shortcut menu of the Hierarchic view icon that
represents the table you are interested in. (Select the icon, then right-click to
open the shortcut menu; move the pointer to highlight View section analysis and
then click to open the view.) Selecting View section analysis automatically
selects the Section probe menu item as well.

If you choose View section analysis for an NIT, SDT, or EIT, a dialog box
opens to permit further selection of table sections. The Select EIT list identifies
the sections by their original network ID (Onid), transport stream ID (TSid),



User Interface

Real-Time Analyzer User Manual 3–61

Service ID, and Table ID. SDT sections are identified by the Onid and TSid. You
can reorder either list by any one of the IDs by clicking the column header.

Highlight the desired subtable and click View Section.

Scrolling Among Subtable Sections. When more than one section of the selected
subtable exists, use the section selection buttons to scroll among the sections.

Section selection buttons

Changing Numeric Display. Although the normal numeric display is hexadecimal,
it may be convenient in some instances to see the decimal value of one or more
fields. Press the F2 function key to toggle between decimal and hexadecimal
display.
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Printing a Section Analysis View. You can print a record of the current Section
Analysis by selecting the view and the choosing Print  from the View menu (or
pressing CTRL+P). Select the view by clicking in the Client window pane; check
the title bar of RTA Application window confirm that the view is selected.

The section rate view contains graphs that show the section rate and time interval
between sections of the selected table.

All scales on the rate and interval graphs are linear. To change the vertical scale
on either graph, clear the corresponding Auto-Scale box and select an appropri-
ate scale increment from the drop-down list box. The Section Rate vertical scale
ranges from zero to four times the selected scale increment; the Section Max
Interval scale ranges from zero to approximately three times the scale increment.
Notice that both vertical scales begin at zero regardless of the scale setting.

The lower Section Max Interval graph displays interval errors in red when the
automatic maximum section interval analysis is enabled, as it is in the standard
configuration (refer to Maximum Interval Between Consecutive Sections on
page 3–13).

Section Rate View
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To open a section rate view of a table, select the corresponding Hierarchic view
icon, right-click to open the shortcut menu, and then click View section rate.

The PTS/DTS analysis view graphs the interval between consecutive time
stamps in the selected elementary stream. The minimum and maximum intervals
between any two of the last 300 time stamps are also shown.

To change the vertical scale of the graph, clear the Auto-Scale box and select an
appropriate scale increment from the drop-down list box. The interval vertical
scale ranges from zero to approximately three times the selected scale increment.

To open a PTS/DTS analysis view of a video or audio elementary stream, select
the corresponding Hierarchic view icon, right-click to open the shortcut menu,

PTS/DTS Analysis View



User Interface

3–64 Real-Time Analyzer User Manual

and then click View PTS/DTS analysis. Selecting View PTS/DTS analysis
automatically selects the PTS/DTS probe menu item as well, activating the
probe for the selected elementary stream only. The PTS/DTS interval graph does
not update unless the PTS/DTS probe is active for the given elementary stream.

The RTA cannot open a PTS/DTS analysis view for a scrambled elementary
stream; therefore, the View PTS/DTS analysis menu choice is unavailable when
the lock symbol appears on the stream icon.

The PCR analysis view is a graphical display of PCR precision and frequency.
The upper graph plots the precision of each clock reference of the selected
program, while the lower graph plots the interval between consecutive references
used by the program. Each graph contains numeric readout of the minimum and
maximum values measured in the last 300 clock references.

Red colored portions of the graphs and red Min or Max readouts indicate that the
data exceeds the RTA PCR error limits. The default interval error limit is 100 ms

PCR Analysis View
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in MPEG-2 mode and 40 ms in DVB mode. Any interval between consecutive
clock references that exceeds these values is reported as an error. The default
precision error limit is +/– 500 ns for both modes. To view or change the PCR
error limits, select Settings from the Configuration menu and then click the PCR
Analysis tab on the resulting Settings window. Refer to PCR Analysis on page
3–87 for more information.

To change the vertical scale on either graph, clear the corresponding Auto-Scale
box and select an appropriate scale increment from the drop-down list box. The
range of the Precision graph is approximately � twice the selected increment;
the range of the Interval graph is from zero to approximately three times the
selected interval.

To open a PCR analysis view, select the appropriate Hierarchic view PMT icon,
right-click to open the shortcut menu, and then click View PCR analysis.

Selecting View PCR analysis automatically selects the PCR probe menu item
as well. The PCR graphs do not update unless the PCR probe is active for the
given program.
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Configuration

Configuration, as used in the Real-Time Analyzer interface, has the following
two meanings:

1. Configuration is the process of changing one or more of the instrument
settings.

2. A Configuration is also the collection of all hardware and software settings
at any given time; that is, the way the RTA is configured.

The Configuration menu has commands for changing the settings and for saving
and restoring configurations. This section discusses use of Configuration menu
commands and explains all of the instrument settings in detail.

Changing the Configuration begins on page 3–68.

Saving and Restoring Configurations begins on page 3–69

RTA Settings begins on page 3–72.

NOTE. RTA settings are saved to the Windows NT registry and automatically
persist from session to session, even if you exit the program and power the
computer down.1 To return all settings to their original states, select Restore
standard from the Configuration menu.

If your use of the RTA requires many deviations from the “standard” settings,
consider saving a baseline configuration profile that contains the settings that
work for your unique situation. Restoring a baseline can be a convenient
alternative to restoring the standard configuration and then making the
necessary configuration changes.

1 You must log in as the same user. RTA settings made by the user “MTS100” and those made by the administrator are
saved in separate registries. For consistent results, always log in as MTS100. The adminstrator can create additional us-
ers to permit several people to use the RTA without settings conflicts. To save and restore configuration profiles, a user
must be a member of either the “Backup Operators” group or the “Adminstrators” group; refer to the Windows NT docu-
mentation for additional information.
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Changing the Configuration

To change the current configuration, choose the Settings command in the
Configuration menu. The resulting Settings window has twelve tabs that contain
settings and options for the various Real-Time Analyzer functions and views.

Click the appropriate tab and then change the setting with standard Windows
techniques: click the appropriate round option button to select among options,
select or clear a square check box, select from a list of several alternatives, or
enter a new value in a text box. Several tabs also have a Restore default button
which you can click to return all settings on the tab to the settings used in the
standard configuration. When you have changed all the appropriate settings on
one or more tabs, click OK  on the bottom of the Settings window to confirm the
changes and close the window. Click Cancel at any time to close the window
without changing any settings.

See RTA Settings, beginning on page 3–72, for complete information about all
options on the twelve Settings window tabs.
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Saving and Restoring Configurations
Through the Configuration menu, you can save all the current RTA settings as a
named profile in the Windows NT registry, you can load a registry profile to
restore a previously saved configuration, and you can restore the standard,
default configuration.

To save the current configuration in the NT registry, choose Save as from the
Configuration menu. The Save configuration window opens.

Either enter a unique name in the Profile name box and click Save to create a
new configuration profile or highlight a name on the List of existing profiles
and click Save to overwrite an existing named profile with the current settings.

To restore an RTA configuration that has been saved in the current user’s NT
registry, choose Load from the Configuration menu. The Load Configuration
window opens.

Highlight the name of the profile that you want to restore (by clicking on the
name in the Profiles list) and then click Load. If a newly loaded configuration
calls for a change in the hierarchy icon size, that change will not occur until you

Save the Current
Configuration

Load a Saved
Configuration
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exit and restart the RTA application; otherwise, there is no need to exit the
application.

To restore the default configuration, stop analysis and choose Restore standard
from the Configuration menu.

NOTE. The Restore standard command is not available when the RTA is
analyzing an input stream. You must stop analysis before you can restore the
default configuration.

Use the Registry Editor program, Regedt32.exe, to delete a configuration profile.

1. Open the Windows NT Start menu and select Run. The Run window opens.

2. Type regedt32 in the Open text box and click OK .

3. Select the HKEY_CURRENT_USER on Local Machine window and
double-click the folder icons to open the path to the RTA profile keys,
HKEY_CURRENT_USER/Software/Tektronix/RTA/1.1/Profiles. The
two named profiles in the following example are “DVB_1” and
“MPEG-2_1.”

Restore the Standard
Configuration

Deleting a Saved
Configuration Profile
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4. Highlight the name of the configuration profile to delete and press DEL  (or
select Delete from the Registry Editor Edit menu). A Warning message
appears; click Yes to confirm the deletion.

5. Exit the Registry Editor.
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RTA Settings

MTS 215 settings tabs

MTS 205 settings tabs

This section describes and explains the RTA settings on the Settings window
tabs. To learn more about the settings on a given tab, refer to the page indicated
in the following list:

� Hardware Configuration; 3–73

� General; 3–74

� Message Views; 3–76

� Hierarchic View; 3–78

� Graphics View; 3–81

� Automatic Analysis; 3–82

� Section Rates Analysis; 3–83

� Transport Rate Analysis; 3–84

� Statistic Analysis; 3–85

� PCR Analysis; 3–87

� Probes List; 3–88

� Filtering Configuration; 3–91

� Data Storage Start/Stop (MTS 215 only); 3–92
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The Hardware Configuration tab contains options for configuring the Real-Time
Analyzer hardware, which is known as the Processing Interface Adaptor (PIA).

There are several options on this tab:

� Input type. Select either DVB-PI // ( LVDS ) ECL//  (parallel; the default) or
DVB-PI ASI  (asynchronous serial).

� Use DEN signal. (Available only when parallel input type is selected.) Select
Use DEN signal to limit analysis to only those packets that have the DEN
(Data Enable) signal asserted. This option is disabled in the standard
configuration.

� Trigger configuration. The trigger configuration applies only if your
instrument contains a Data Store system and you intend to use an external,
TTL-level (0 V to +5 V) signal to start/stop data storage. Choose to trigger
on either the rising edge or the falling edge of the trigger signal.

� Output level. Select either LVDS or Modified ECL  (the default).

Modified ECL output is nominally 400 mVpp; standard ECL is approximate-
ly 700 mVpp.

� The number of correct consecutive synchronization bytes to test before
indicating that the synchronization has been found.

Hardware Configuration



Configuration

3–74 Real-Time Analyzer User Manual

The choices are 3, 5, 7 or 9 correct synchronization bytes; the default is 5.
Click the arrow to the right of the current value and select the desired value
from the resulting list.

� The number of bad consecutive synchronization bytes to test before
indicating that the synchronization has been lost.

The choices are 1, 3, 5, or 7 correct synchronization bytes; the default is 3.
Click the arrow to the right of the current value and select the desired value
from the resulting list.

To restore all standard hardware configuration settings, click Restore default.

The General tab contains the most basic RTA operating options.

MPEG-2 or DVB. This option determines whether the RTA monitors for com-
pliance to the MPEG-2 or the DVB standard. Choose MPEG-2 (the default) if
the stream you are analyzing complies with the MPEG standard but not DVB;
choose DVB if the input stream complies with all or most of the DVB standard.
You may have to ignore many false error reports if you select DVB to monitor a
stream that does not comply fully with the DVB standard. Notice that another

General
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option (Map private sections...) appears under Syntaxic Analysis when you
choose to monitor for DVB compliance.

Event Viewer. Select this option to log all events detected by the RTA to the
Windows NT Event Viewer. Clear the option to prevent RTA error and message
logging. Event Viewer is selected in the default configuration.

NOTE. The Event Viewer is set during software installation to overwrite
application log events as needed. This can result in lost information when
monitoring an input stream that contains many errors. However, selecting
another Event Viewer log wrapping option can result in buffer overflow and can
freeze the RTA. You can increase the size of the Event Viewer application log; do
not change the log wrapping setting without good reason.

For further information about the Event Viewer, refer to Messages and the Event
Viewer on page 3–45 of this manual. Also consult the Windows NT documenta-
tion and the Event Viewer online Help.

Hexa Display. The Hexa display option causes the RTA to display most numeric
values in hexadecimal base. Clear this option to display values in decimal base.
You can also toggle this setting during normal operation by pressing the F2

function key.

Map private sections as DVB sections. This option appears when you have
selected DVB monitoring through the first option on the tab. When you select
this option, the RTA attempts to interpret all private sections encountered in the
stream as DVB SI sections. The option is not present in the standard configura-
tion, which has MPEG-2 monitoring selected. The option is cleared when you
first specify DVB monitoring; select it if necessary to force the RTA to interpret
PIDs 0x10 through 0x14 as SI.
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Maximum number of errors by entity. This option limits the number of errors that
the RTA detects before stopping analysis for a single input stream item. A “too
many errors” message indicates an instance in which the RTA has reached this
maximum.

Current Profile. If you have loaded a saved configuration profile (through the
Load command on the Configuration menu), the name of that profile appears in
this box. The background is gray because the profile cannot be changed through
the General Settings window tab.

To restore all standard general settings, click Restore default.

The Message Views tab contains settings options that apply to all Message
views.

The Display portion of the tab gives you the opportunity to limit the types of
messages displayed and logged to the Event Viewer (if Event Viewer is selected
in the General tab).

Information messages. Selected by default, Information messages alert you to
input stream events that are not considered errors, but may be important to your
stream analysis. These events include as PSI and SI table updates, the presence
of ghost (unreferenced) packets, and error disappearance. Clear the Information
messages check box to prevent the display and logging of these information
events.

Message Views
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Error messages. Error messages, also selected by default, inform you of all errors
detected in the input stream. The number and types of errors detected by the RTA
depend, in part, on your selections on the various Settings window tabs.

TDT and TOT Update message. This option is not selected in the standard
configuration. Select TDT and TOT Update message to see and log informa-
tion messages that report TDT (time and date table) and TOT (time offset table)
updates.

EMM Update message. This option is also cleared in the standard configuration.
Select EMM Update message to see and log information messages that report
EMM (Entitlement Management Message) updates.

The Messages portion of the tab contains display and logging options that affect
all messages.

Maximum number of messages. This option limits the number of messages that
any Message view can contain. The maximum includes those messages that have
scrolled off the top of the current message window or window pane; use the
vertical scroll bar to see the messages that will not fit in the display window (you
may have to press F3 to pause view updates when monitoring a stream with many
errors). When a Message view reaches the specified maximum, the oldest
message is discarded as each new message appears. The default maximum for
the general Message view is 1000 messages; the default for all other views is 50.

This setting does not affect the capacity of the Windows NT Event Viewer
application log.

Only one message with the same event id in Event Viewer. Limits the amount of
message detail logged to the Event Viewer.

The RTA posts only one general message for each event ID in the Message
views. In reality, a Message view entry can represent many error or information
messages. In the standard configuration, all information or error detail repre-
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sented by the general message is logged to the Event Viewer. Double-clicking on
the message opens a window that provides access to the event details.

The event ID actually
represents four messages

Click Next to see the
second message

When you are monitoring a stream that contains many items with many errors,
logging all details can delay the appearance of messages in the Message views
and quickly fill the Event Viewer application log. To log only general messages
to the Event viewer, select this option.

The Hierarchic View tab contains options that apply only to the Hierarchic view.

Big icons, selected in the standard configuration, causes the RTA to use the larger
of the two available icon sizes in the Hierarchic view. See the following screen
captures for a comparison of the two icon sizes.

Hierarchic View
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Clear this selection to use small icons. The change will not take effect until you
exit and restart the RTA application.

Big hierarchy icons Small hierarchy icons
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More information. This option controls the Hierarchic view display of additional
information to the right of the standard icon information. During normal
operation, you can press F6 to toggle this selection. More information  is not
selected in the standard configuration.

The standard configuration:

More information selected:

Number of levels to display. This option controls how many hierarchy levels are
shown in the Hierarchic view. Click the arrow to reveal the choices; each choice
includes the F-key equivalent, which you can use to expand or collapse the
hierarchy during normal operation. The default selection is 1 F7, which displays
only the top level of the hierarchy. See the following examples.

Select 1 or press F7 to hide all
but the top-level hierarchy items.

Select 1 or press F8 to show only
the top two hierarchy levels.

Select 4 or press F10 to show
all items in the hierarchy.
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Graphic Views tab settings determine how the RTA updates the various analysis
graphs. In the standard configuration, Scrolling is disabled for all graph types.

When Scrolling is disabled, the passage of time is indicated with a moving
cursor. The cursor—visible in the graph below—moves from left to right. The
most recent data are immediately to the left of the cursor; the oldest data are
immediately to the right of the cursor.

When Scrolling is selected, the cursor disappears after the first sweep and the
data itself then moves from right to left on the graph as if the right border of the
graph has become the cursor. The most recent data are at the right end of the
graph; the oldest data continually scroll off the left end.

Graphic Views
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The Automatic Analysis tab provides a way to limit the analyses that are
performed at the multiplex, transport packet, and table section levels. In the
standard configuration, all analyses are selected.

You can disable/enable individual analyses by clearing/selecting the associated
check box; you can disable or enable all Multiplex Level, all Transport Level, or
all Section Level analyses by clicking the associated Reset All or Set All button.

NOTE. Several Automatic Analysis selections control DVB-MG tests. Do not
disable any automatic analyses if you plan to use DVB-MG tests to judge DVB
compliance of the input stream.

Refer to Automatic Analyses on page 3–7 for a complete discussion of all
analyses on this tab.

Automatic Analysis
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Use the Section Rates Analysis tab to specify the maximum acceptable interval
between consecutive table sections of each table type. When you have configured
the RTA for MPEG-2 monitoring, only the PAT, PMT, CAT, and NIT Actual
settings are available; when you have configured the RTA for DVB monitoring,
all settings are available.

The RTA uses the Section Rate Analysis intervals when the Maximum interval
between consecutive sections option on the Automatic Analysis tab is selected.

NOTE. These settings determine the threshold for errors reported on the
DVB-MG view. The default settings are consistent with DVB-MG recommenda-
tions. Do not change these settings if you plan to use DVB-MG tests to judge
DVB compliance of the input stream.

The second zone on this tab reports that 25 ms is the minimum permissible
interval between consecutive sections when the Minimum interval between
consecutive sections option on the Automatic Analysis tab is selected. This
value cannot be changed by the user.

Click Restore default to restore all standard section rate analysis interval values.

Section Rates Analysis
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The Transport Rate Analysis tab lists the transport rate error thresholds (limits)
that the RTA is monitoring and provides a way to set, modify, and remove
transport rate error thresholds for any stream component.

NOTE. You can also set and remove transport rate error thresholds through the
shortcut menu of each Hierarchic view icon. Refer to Shortcut Menus on
page 3–41 and Transport Rate Analysis on page 3–1 for more information.

Setting Thresholds and Beginning Analysis. To set new rate limits and initiate
transport rate analysis through this tab, perform the following steps:

1. Enter the PID of the stream item in the Rate interval check PID field.
Either enter the hexadecimal value of the PID (such as 0x21) or clear the
Hexa display selection and then enter the decimal PID (such as 33).

2. Enter the low error threshold, if any, in the Low Limit  field.

3. Enter the high error threshold, if any, in the High Limit  field.

4. Click Add.

Transport rate analysis of the stream item begins when you click OK to close the
Settings window.

Transport Rate Analysis
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Changing Thresholds. Perform these steps to change one or both of the the error
thresholds for a stream item:

1. Click on the item entry on the List of checked intervals to highlight the
entry and to enter the information into the Rate Interval check fields.

2. Change the Low Limit  and High Limit  as necessary. To remove a threshold
(the list entry becomes “Not checked”), double-click in the field and then
press DELETE.

3. Click Modify .

The new transport rate analysis threshold(s) take effect when you click OK to
close the Settings window.

Stopping Analysis. Removing an item entry from the List of checked intervals
ends analysis for a single stream item. To remove an item, highlight the list entry
and then click Remove. To end transport rate analysis of all listed items, click
Remove all. Analysis will end for the removed items when you click OK  to
close the Settings window.

The Statistic Analysis tab contains settings that apply to two types of automatic
analysis.

Transport Rate Smoothing time. Smoothing time is the period over which the
RTA averages the transport rates reported in the Statistic view Program Alloc

Statistic Analysis
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and PID Alloc panels. The default value is one second; you can enter any integer
value from 1 to 10. In most cases, selecting a longer smoothing time reduces the
range over which reported transport rates vary.

Alarm if item not present [etc.] Use these settings to specify the permissible
interval between the first table section that lists a stream item and the appearance
of that item in the stream. The RTA reports an error if the item does not appear
before the end of the interval. The default value is one second; you can enter any
integer value from 0 to 10. If you enter 0, the RTA reports an error if the item is
not present in the stream before it is referenced in a table.

Item

Associated table (table that lists the item)

NOTE. Several of these settings are used as criteria for the DVB-MG PID_error
reported on the DVB-MG view. The measurement guidelines state that the
precondition for a PID_error is that a “referred PID does not occur for a user
specified period.” Changing a time interval on this tab does not affect the
accuracy of the results displayed in the DVB-MG view.

Click Restore default to restore all standard statistic analysis values. New
Statistic analysis settings take effect when you click OK  to close the Settings
window.
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The PCR Analysis tab contains settings options that apply only to user-initiated
PCR analysis and PCR probes.

Interval. These settings specify the maximum permissible interval between
consecutive PCRs. When a PCR probe is active, the RTA reports an error when
the interval between two consecutive PCRs for the monitored program exceeds
the applicable (DVB or MPEG-2) value. The default for DVB mode is 40 ms;
the default for MPEG-2 is 100 ms.

Max and Min. These settings specify the maximum permissible deviation from the
expected PCR value. When a PCR probe is active, the RTA reports an error when
the deviation falls outside of the Max and Min  values. The default for both DVB
and MPEG-2 mode is +500 ns/–500 ns.

NOTE. These settings determine thresholds for errors reported on the DVB-MG
view. The default settings are consistent with DVB-MG recommendations. Do not
change these settings if you plan to use DVB-MG tests to judge DVB compliance
of the input stream.

Frequency Offset. The threshold for a frequency offset error. The default for both
DVB and MPEG-2 mode is 30 ppm.

PCR Analysis
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Drift Rate Max. The threshold for a frequency drift rate error. The default for both
DVB and MPEG-2 mode is 10 ppm/hr.

Mask Discontinuities. Under normal circumstances, the Real-Time Analyzer uses
every PCR value in the stream to build the accuracy model that is used to judge
the jitter of each newly decoded PCR. Occasional discontinuities (large PCR
errors due to looped input, for example) can prevent creation of a valid model
and hinder PCR analysis. Select Mask discontinuities to ignore very inaccurate2

PCRs, both for error reporting and for calculating the PCR jitter model.

Refer to PCR Analysis on page 3–18 for more information about PCR analysis
and PCR probes.

Click Restore default to restore the standard PCR analysis settings. New
settings take effect when you click OK  to close the Settings window.

The Probes List tab lists all active probes and provides a way to set and remove
the various probes (section syntax, PCR, PTS/DTS, and InterSI) for one or more
stream items.

2 The difference between the expected PCR value (interpolated from previous values) and the decoded PCR value is greater
than 1.0 ms.

Probes List
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NOTE. You can also set and remove probes through the shortcut menus of the
appropriate Hierarchic view icons. Refer to Shortcut Menus on page 3–41.

Probes List Conventions. The following conventions apply to the Probes List:

� The Table type list contains only the tables consistent with the current
monitoring mode (MPEG-2 or DVB).

� The Probes List on the right side of the tab lists all active probes, including
those activated through the Hierarchic view.

� Setting a probe through the Probes List tab also checks the corresponding
probe command on the shortcut menus of all affected stream items.

� Removing a probe from the Probes List also deselects the corresponding
probe command on the shortcut menus of affected stream items.

Adding and Activating a Section Syntax Probe. You can set a section syntax probe
on one or more stream items with the following procedure:

1. Highlight the table name in the Table type list.

2. For PMT, enter the desired program number below the Table type list or
select the ALL check box to probe all PMTs in the stream. For Private
Tables, ECM, and EMM, enter the PID of a particular table or select the
ALL check box to probe every table of that type in the stream.

3. Click Syntax in the Probe Type list.

4. Click Add to add the section syntax probe to the Probes List.

5. Click Apply to activate the probe. If you do not click Apply, all probes on
the list become active when you close the Settings window.

Adding and Activating a PCR probe. You can add and activate a PCR probe with
the following procedure:

1. Highlight PMT  on the Table type list.

2. Enter the desired program number below the Table type list or select the All
check box to probe all PCRs in the stream.

3. Highlight PCR in the Probe Type list.

4. Click Add.

5. Click Apply to activate the probe. If you do not click Apply, all probes
become active when you close the Settings window.
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Adding and Activating a PTS/DTS probe. Add and activate a PTS/DTS probe with
the following procedure:

1. Highlight Elementary Stream on the Table type list.

2. Enter an elementary stream PID below the Table type list or select the All
check box to probe all PTS/DTS in the stream.

3. Click Add.

4. Click Apply to activate the probe. If you do not click Apply, all probes
become active when you close the Settings window.

Adding and Activating the InterSI probe. Add and activate the InterSI probe with
the following procedure:

1. Highlight any SI table (NIT, SDT, EIT, or BAT) on the Table type list.

2. Highlight InterSI  on the Probe Type list.

3. Click Add.

4. Click Apply to activate the InterSI probe. If you do not click Apply, all
probes on the list become active when you close the Settings window.

Setting All Probes. Click Add All  and then click Apply  to set every probe
possible on every input stream table, program, and elementary stream.

NOTE. Unless the input stream is compliant with almost every aspect of the
MPEG-2 or DVB standard (whichever is applicable), setting all probes can
result in many error messages, which can begin to fill the buffer and slow the
RTA to less than real-time performance.

Removing Probes. To remove a single probe, either highlight the probe entry in
the Probes List and click Remove or simply double-click the Probes List entry.
To remove all probes, click Remove All.

In either case, the probe(s) remain active until you click OK to close the
Settings window.
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The Filtering Configuration tab options enable PID-based filtering, in which
only selected PIDs are passed to the parallel output. On an MTS 215, you can
use these settings to select and limit the portion of the input stream that is
captured to the Data Store disks during data storage.

Select the default option, No filtering mechanism, to pass the entire input
stream to the parallel output during analysis and to capture all input stream items
during data storage.

When you choose PID based filtering, only the transport packets whose PIDs
you have added to the Selected PIDs list are passed to the parallel output or
captured.

Adding PIDs. There are several ways to add PIDs to the Selected PIDs list:

� Enter a PID directly into the upper-left list box and click the adjacent
(upper)❯❯  button. Numeric entry must be hexadecimal (for example, 0x10)
unless you have cleared the Hexa display check box. If you clear the check
box, you must enter the decimal value of the PID (16, for example, instead
of 0x10).

� Select an individual PSI or SI PID from the upper-left list box and click the
upper ❯❯  button. The choices are 0x0 (PAT), 0x1 (CAT), 0x10 (NIT), 0x11
(SDT), 0x12 (EIT), 0x13 (RST), and 0x14 (TDT).

� Select a program from the lower-left list box and click the adjacent (low-
er) ❯❯  button. The RTA automatically adds the PIDs of the program-defining
PMT and all elementary streams and ECM sections in the program to the
Selected PIDs list.

Filtering Configuration
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� Select PSI or SI from the lower-left list box and click the lower ❯❯  button.
The RTA automatically adds the PIDs of all PSI or SI tables in the stream to
the Selected PIDs list.

Removing PIDs. To remove a single PID from the Selected PIDs list, either
highlight the PID and click Remove or simply double-click the PID. To remove
all PIDs from the list, click Remove All.

The Data Storage Start/Stop Settings window tab is present only in the
MTS 215, which contains both the RTA and the Data Store system. Use the Data
Storage Start/Stop settings to select the method of initiating data storage, the
conditions that will stop data storage, and how much of the input stream is to be
captured.

Start Condition. A Data Storage Start condition initiates RTA data acquisition
mode. When the RTA is in acquisition mode, the specified portion of the input
stream preceding, following, or including the first-encountered Stop condition
(or “storage event”) is saved to a file.

The Manual Start condition is always active. In the default configuration, you
must initiate data acquisition by selecting Start from the Data Storage menu or
by clicking the Start acquisition toolbar button.

Data Storage Start/Stop
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Select Use Trigger to also make it possible to initiate acquisition with a rising or
falling TTL-level signal applied to the RTA Trigger input. Refer to Trigger
Configuration on page 3–73 for additional information.

NOTE. The option appears either as Use Trigger (Rising edge) or as Use
Trigger (Falling edge), depending on the Trigger configuration selection on the
Hardware Configuration Settings tab.

Stop Conditions. Select one or more Stop conditions that, when detected or
encountered during data acquisition, will cause the actual storage of input data to
an event trace file.

You can select one or more of the following Stop conditions:

� External TTL-level trigger

� All level 1 DVB-MG tests

� Individual level 1 DVB-MG tests

� All level 2 DVB-MG tests

� Individual level 2 DVB-MG tests

� All level 3 DVB-MG tests conducted by the RTA

� Individual level 3 DVB-MG tests

NOTE. A selected Stop condition must be detected by the RTA to cause data
storage. Always confirm that the related analysis or probe is enabled before
beginning data acquisition. To confirm that a DVB-MG test is enabled, open the
DVB-MG view and verify that the test indicator is green, orange, or red (not
gray).

The Manual Stop condition cannot be disabled, so you can always select Stop
from the RTA Data Storage menu or click the Stop acquisition toolbar button to
end data acquisition mode. No other Stop conditions are enabled in the default
configuration.

Data acquisition ends in the default configuration when the RTA saves the event
trace file. However, a Stop condition event does not end data acquisition when
you select Enable automatic trace sequencing. Instead, the RTA continues to
monitor the input stream in data acquisition mode and attempts to save an event
trace file for every Stop condition encountered. You must manually stop
acquisition when automatic trace sequencing is enabled.
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To select Stop conditions,

1. If necessary, click the appropriate “+” box to expand the hierarchy and then
click the hard disk icon of the desired Stop condition. You can click the
“DVB-MG tests: Level n” icon to select all DVB-MG tests in the level.

NOTE. You can move the highlight within the Stop Condition hierarchy with the
keyboard arrow keys. You can also expand one level of the hierarchy with the
“+” numeric keypad key, open the entire hierarchy with the “*” keypad key, and
close the hierarchy with the “–” keypad key. The exact effect of these keystrokes
depends on the context; experiment and practice to become proficient at
keyboard hierarchy navigation.

A green check mark appears on the disk icon to show that the Stop condition is
selected. A gray check mark appears on the parent “DVB-MG tests: Level n”
disk icon to show that one of the tests in that level is selected.

By default, the event trace data are stored on the Single shot Data Store partition.
The file is specified in the File name text box. You can enter an alternate file
name and you can click Browse to save the data onto the system disk. Refer to
File Name and Path Conventions on page 3–95 for additional information.

2. Once you have selected a Stop condition, specify the desired amount of input
stream to capture before and after the data storage event. By default, the
event trace data are the 5 000 048 Bytes of input received before the Stop
condition occurs. Refer to Specifying Trace Size Before and After the Event
on page 3–96 for more information.

3. Repeat steps 1 and 2 for each Stop condition that you want to detect and
trace.
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4. Select Enable automatic trace sequencing, if appropriate, to save event
trace files for more than one Stop condition event.

5. Click OK  at the bottom of the Settings window to confirm all Data Storage
Start/Stop settings and close the window.

File Name and Path Conventions. The event trace file can contain input data
received before the Stop condition event, after the event, or both before and after
the event. If the Stop condition is a DVB–MG error, you can later examine the
event trace file with the MPEG–2 System (Deferred–Time) Analyzer to
determine the causes or effects of the error.

� An event trace file name is automatically assigned when you select a Stop
condition. For example, the file name for a DVB–MG 1.1 (TS_sync_loss)
error trace is DVB11nn.trp, where “nn” is a hexadecimal number assigned
when the file is created. When the first DVB–MG 1.1 error is detected, the
RTA saves DVB1100.trp. File names increment (DVB1101.trp,
DVB1102.trp, ...) for each subsequent data capture. To force the file names
to begin again at 00, you must delete all Data Store event trace files with the
same root name (DVB11*.trp, for example) and then, through the RTA
Configuration menu, restore the standard configuration or load another
configuration that was saved when the counters were 00.

� By default, event trace files are saved to the Single Shot partition of the Data
Store disks, which is also visible in Windows NT as C:\Carb0\Mono. You
can choose instead to save event trace files to the system disk. To save data
to the C:\Mts200\Cfg-trp directory, for example, click Browse (to the right
of the File name field) and then click the Open button in the resulting Open
window. The path then appears in the file name field.

� You can enter an alternate name for the event trace file; the RTA automatical-
ly uses the first six characters of the name and appends the appropriate
sequence number (nn = 00, 01, 02, ...) when it saves the file. For best results,
always delete all previous trace files that pertain to the same event and restart
the RTA application before saving under a new name. Use only alphanumer-
ic characters or an underscore in the file name. The data store system cannot
transfer files to other disks if the file name contains characters such as “–”
(hyphen), “ ” (space), “.” (period), or “+” (plus).
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Ask Before Saving. Select Ask before saving to display the following window
when the stop condition is encountered.

Specifying Trace Size Before and After the Event. The default event trace file
contains the five Mbytes of input received immediately before the event. You can
configure the RTA to save as much or as little data before and after the event as
you like, limited only by the size of the Single Shot partition. You can change
the Before event and After event file sizes with the following techniques:

� Select the most convenient units (Seconds, Bytes, or Packets) and then enter
the quantity. Notice that changing the selection from Bytes to Packets or to
Seconds converts the quantity into the correct units. You can select Seconds
only when analysis is occurring; you cannot select Seconds when PID based
filtering is selected (on the Filtering Configuration tab).

� Click Max to enter the entire Single Shot Data Store partition.

� Click Center trace to enter half of the Single Shot partition size in the
Before event field and half of the partition size in the After event field.

� Click Reset to deselect the error condition and clear Enable event trace,
restore the default file name, and restore the default event trace sizes.

NOTE. When the RTA detects a stop condition, it must communicate with the data
store system to initiate the actual saving of an event trace file. Under normal
circumstances, this communication takes approximately 0.5 seconds. Therefore,
if you want to save the packet that contains a triggering DVB-MG error, do not
set the Before event value to less than 0.5 seconds of input data. The default
value, 5 Mbytes, is adequate for most input streams.
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Data Storage Examples. The following numbered examples assume that the RTA
is analyzing an input stream.

1. To capture a set portion of the input stream:

a. On the Filtering Configuration settings tab, select No filtering
mechanism.

b. On the Data Storage Start/Stop settings tab, click Reset All, change the
Manual Stop Before event value to 0 (zero), and the After event value
to the desired duration (seconds) or size (bytes).

c. Click OK  to confirm the settings and close the Settings window.

d. Through the Data Storage menu (or with the corresponding command
button), start data storage.

e. To trigger data storage, select Stop from the Data Storage menu or click
the corresponding toolbar button. The Real-Time Analyzer saves the
specified portion of the input stream to the file MnStopnn.trp on the
single shot partition of the data store disks (nn is a hexadecimal number
that increments as succeeding manual stop files are saved). A message
appears in the General message view when the entire MnStopnn.trp file
is saved.

NOTE. During RTA data storage, the test system must first acquire the event
trace data and then rewrite that data to a contiguous file at the beginning of the
free space on the data store disks.3 As a result, the time required to save an event
trace file—from stop condition detection to the appearance of the “Data are
stored...” message—can be up to twice the time required to acquire the event
trace data.

Remember, you can configure the RTA to pass input directly through to the
parallel output, and you can capture that data directly with the Data Store
Administrator application. Capturing a large file (that does not begin or end
with a particular DVB-MG error) directly with the Data Store Administrator can
require much less time than using RTA data storage to capture the same file.
Because the Data Store Administrator and RTA can run simultaneously, you can
still monitor and analyze the input with the RTA as you are capturing it on the
data store disks.

2. To capture the 5 Mbytes of data immediately preceding the first level 1
DVB-MG error in the stream:

a. Select DVB-MG view from the View menu and then click Detailed.
Confirm that all Priority 1 tests are active (no indicators are gray).

3 Refer to the MPEG Test System Deferred-Time Applications User Manual for additional information about file manage-
ment on the data store disks.
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b. On the Filtering Configuration settings tab, select No filtering
mechanism.

c. On the Data Storage Start/Stop settings tab, click Reset All and then
click the “DVB-MG tests: Level 1” disk icon. A green check mark
appears on the icon to indicate that all level 1 tests are designated as stop
conditions.

d. Click OK  to confirm the settings and close the Settings window.

e. Select Start acquisition from the Data Storage menu (or click the
corresponding command button).

When the next Priority 1 DVB-MG error is detected, the RTA stops data
acquisition and saves the 5 Mbytes of input that immediately preceded the
error. The event trace file is DVBLv1nn.trp on the Single shot Data Store
partition.

3. To monitor the input for an extended period and capture only the PSI and SI
tables immediately preceding and following an NIT_error (DVB-MG 3.1.1),
an SDT_error (DVB-MG 3.5.2), or an EIT_error (DVB-MG 3.6.2):

a. Select DVB-MG view from the View menu and then click Detailed.
Confirm that NIT_error (DVB-MG 3.1.1), SDT_error (DVB-MG 3.5.2),
and EIT_error (DVB-MG 3.6.2) tests are active.

b. On the Filtering Configuration settings tab, select PID based filtering;
if necessary, click Remove All to clear the Selected PIDs list; highlight
PSI in the left-hand list and click the >> button; highlight SI in the
left-hand list and again click >>.

c. On the Data Storage Start/Stop tab, click Reset All; then, in the Stop
conditions list, click the “+” box next to the “DVB-MG tests: Level 3”
disk icon.

d. Click the “3.1.1 NIT_error: ...” Stop condition (hard disk) icon; a green
check mark appears on the icon. Then change the Before event and
After event values to 20 Packets. (First click the Packets button, then
enter 20 in the text box.)

e. Repeat step d for both the “3.5.2 SDT_error: ...” and the “3.6.2
EIT_error: ...” Stop conditions.

f. Select Continuous acquisition and then click OK  on the bottom of the
Settings window to confirm all your settings and close the window.

g. Select Start acquisition from the Data Storage menu (or click the
corresponding command button).
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If you let the RTA monitor the input stream for an extended period (over-
night, for example), it will capture and store only PSI and SI table sections
received immediately before and after any of the selected errors.

� Event trace files for a DVB-MG 3.1.1 error are stored on the Single shot
partition of the Data Store disks as DVB311nn.trp.

� Files for DVB-MG 3.5.2 errors are named DVB352nn.trp.

� Files for DVB-MG 3.6.2 errors are named DVB362nn.trp.

In each of the above file names, “nn” is a hexadecimal number that is 00 for
the first file saved and increments for each subsequent file with the same root
name (DVB352, for example).

h. To stop acquisition, select Stop acquisition from the Data Storage menu
or click the corresponding command button.

i. The RTA saves the last 5 Mbytes of acquisition to MnStopnn.trp, also on
the Single shot Data Store partition.
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Appendix A: DVB-MG Measurements

The DVB Measurement Guidelines (ETR 290) have been issued by the
DVB-MG group. This document provides guidelines for measurement in Digital
Video Broadcasting (DVB) satellite, cable and terrestrial and related digital
television systems. The document is designed to define a number of measure-
ment techniques, such that the results obtained are comparable when the
measurements are carried out in compliance with the appropriate definition.

Chapter 5 of ETR 290 recommends and defines tests at the Transport Stream
level. The recommendations are grouped into three categories of importance:

� First priority: necessary for decodability (basic monitoring)

� Second priority: recommended for continuous or periodic monitoring

� Third priority: application-dependent monitoring

The Real-Time Analyzer performs most first, second, and third priority
DVB-MG measurements, either automatically or at user request. Table A–1 lists
the measurements recommended in ETR 290 and indicates how the RTA
performs each one.

Table A–1: DVB-MG tests in the RTA 
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Table A–1: DVB-MG tests in the RTA (Cont.)
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Tests 3.3, 3.9, and 3.10 concern the T-STD (the hypothetical Transport Stream
System Target Decoder) and are too computation-intensive to be performed by
the Real-Time Analyzer. You can perform T-STD analysis with the deferred-time
analyzer that is part of the MTS 215 if you first capture part of the input stream
to the Data Store disks. Refer to the MTS 210 MPEG Test System User Manual
for more information.

First Priority Measurements
The RTA continuously monitors all of the DVB-MG first priority parameters.

Each packet of the transport stream is preceded by a header consisting of four
bytes. The first byte of the header is the synchronization byte (SyncByte), whose
content is always the hexadecimal value 0x47. In the MPEG-2 decoder, the
SyncByte serves for synchronization with the packetized transport stream. DVB
recommendations define synchronism such that a sequence of at least five
SyncBytes has to be detected by the MPEG-2 decoder. Synchronism is lost if the
SyncBytes in a sequence of at least three TS packets are not detected according
to the DVB recommendations. This status is referred to as TS_Sync_Loss.

In the DVB Measurement Guidelines (ETR290), the preconditions for a
TS_Sync_Loss message is as follows:

Indicator Precondition Reference
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Loss of synchronization with consideration of
hysteresis parameters
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ISO/IEC 13818-1:
Sub clause 2.4.3.3 /
annex G.01

TS_Sync_Loss (1.1)
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Each packet of the transport stream is preceded by a header consisting of four
bytes. The first byte of the header is the synchronization byte (SyncByte), whose
content is always the hexadecimal value 0x47. In the MPEG-2 decoder the
SyncByte serves for synchronization with the packetized transport stream. If the
SyncByte is missing or contains errors too often, the decoder will not be able to
synchronize to the transport stream.

The MPEG test decoder checks the SyncByte of every packet in the transport
stream for correct contents.

The precondition for a SyncByte_Error message is defined in ETR 290 as
follows:

Indicator Precondition ReferenceÁÁÁÁÁÁÁ
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Sync_byte_error
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ISO/IEC 13818-1:
Sub clause 2.4.3.3

The Program Association Table (PAT) contains a list of all programs and PIDs
contained in the transport stream and of associated PMTs (Program Map Tables),
which contain detailed program descriptions. The PAT is of key importance for
decoding TV and audio programs. If the PAT is not available or contains an
error, the MPEG-2 decoder will not be able to select and decode a program from
the transport stream multiplex.

The syntactic structure of a PAT is comprehensively defined in MPEG-2 systems
(ISO/IEC 13818–1). The PAT is exclusively transmitted in packets with PID
0x0000. The table may be divided into a maximum of 256 sections with the table
index (table_id) of each section being 0x00.

The preconditions for a PAT_Error message are defined in ETR 290 as follows:

Indicator Precondition Reference
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PID 0x0000 does not occur at least every 0.5
seconds

A PID 0x0000 does not contain a table_id
0x00 (that is, a PAT)

Scrambling_control_field is not 00 for PID
0x0000
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ISO/IEC 13818-1:
Sub clauses 2.4.3.3,
2.4.4.4

Each packet of the transport stream is preceded by a header consisting of four
bytes. The fourth byte of the header contains the count of a four-bit continuity
counter. The count must be increased by one for every packet of the transport
stream that has the same PID. The count may consist of values ranging from 0 to
15; beyond 15, it will start from 0 again (modulo-16 counter). The continuity

Sync_byte_error (1.2)

PAT_error (1.3)

Continuity_count_error
(1.4)
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counter serves to recognize packets of a video or audio program that are either
missing or repeated more than once.

The MPEG-2 standard also tolerates counter discontinuity, provided this is
indicated by a discontinuity indicator in the optional adaptation field (AF) of the
same packet. This method is primarily used for the suppression of error messages
when changing programs preceded by remultiplexing of the transport stream.

In the case of null packets (packets that do not contain any useful data but have a
PID of 0x1FFF), continuity is not checked, since the value of the continuity
counter in zero packets is not defined in the MPEG-2 standard.

The preconditions for a Continuity_Count_Error_Error message are defined in
ETR 290 as follows:

Indicator Precondition Reference
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Incorrect packet order

A packet occurs more than twice

Lost packet
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ISO/IEC 13818-1:
Sub clauses 2.4.3.2,
2.4.3.3

The PMT (Program Map Table) is a table for detailed program descriptions
referenced in the PAT. As essential information for the MPEG-2 decoder, it
contains the PIDs of all packets of the individual TV, audio, and data streams
(elementary-stream PIDs) as well as the PIDs of packets serving for the
transmission of PCR values associated with the program. Like the PAT, the PMT
is of key importance for decoding TV and audio programs. If PMT is not
available or contains an error, the MPEG-2 decoder will not be able to select and
decode a program from the transport stream multiplex.

The syntactic structure of a PMT is defined in MPEG-2 systems (ISO/IEC
13818-1). In contrast to the PAT, the PIDs of the individual PMTs are variable;
MPEG-2 permits values ranging from 0x0010 to 0x1 FFE (compare to DVB
ETS 300468: 0x0020 to 0x1 FFE). The table may be divided into a maximum of
256 sections with one section for each program. The table index (table_id) of
each section must be 0x02.

ETR290 states the preconditions for a PMT_Error message as follows:

Indicator Precondition Reference
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Sections with table_id 0x02, (that is, a PMT),
do not occur at least every 0.5 sec on the
PID which is referred to in the PAT

Scrambling_control_field is not 00 for all
PIDs containing sections with table_id 0x02
(i.e. a PMT)

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ISO/IEC 13818-1:
Sub clauses 2.4.3.3,
2.4.4.4, 2.4.4.8

PMT_error (1.5)
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The PMT (Program Map Table) entries reveal the elementary-stream PIDs that
are contained in the transport-stream multiplex. To decode a program with the
corresponding PID, these packets must be contained in the transport stream, and
for the MPEG-2 decoder to function error-free these packets also need to be
transmitted at certain intervals. The DVB Measurement Guidelines speak of a
user-specified period, which means that it can be freely selected by the user. The
default value used by the RTA is 1 second; you can change this value through the
Statistic Analysis tab of the Settings window, which opens when you choose
Settings from the RTA Configuration menu.

ETR 290 states the precondition for a PID_Error message as follows:

Indicator Precondition Reference
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

PID_error ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Referred PID does not occur for a user-spe-
cified period

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

ISO/IEC 13818-1:
Sub clause 2.4.3.8

Second Priority Measurements
The DVB-MG recommends “continuous or periodic” monitoring of second
priority parameters. The RTA monitors most second priority parameters
automatically. For maximum flexibilty, however, you can set PCR and PTS/DTS
probes on the programs and elementary streams of your choice; you must do so
to perform measurements 2.3, 2.4, and 2.5.

The second byte of every packet header in the transport stream contains the
transport_error_indicator, which is a flag that serves to indicate bit errors in the
following packet. This flag is generated and inserted by the Viterbi or Reed-Sol-
omon decoder at the receiver end if the decoder is no longer capable of correct-
ing all bit and byte errors in the transport stream.

Because it is not possible in the case of a set transport_error_indicator to predict
which bit or byte contains an error, this packet must not be evaluated by an
MPEG-2 decoder. For this reason, the MPEG test decoder only indicates the
Transport_Error, which means that the packet is not checked for further transport
stream errors.

ETR 290 states the precondition for a Transport_Error message as follows:

Indicator Precondition Reference

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Transport_error ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Transport_error_indicator in the TS-Header
is set to ’1’.

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

ISO/IEC 13818-1:
Sub clauses 2.4.3.2 /
2.4.3.3

PID_error (1.6)

Transport_error (2.1)
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If program-specific information (PSI tables), such as PAT, CAT, PMT, NIT, EIT,
SDT, BAT and TOT, is transmitted, a value for checking the check sum of this
section is inserted at the end of each table section. The CRC (Cyclic Redundancy
Check) is used for calculating the check sum at the transmitter and receiver end.
Combined with the additionally transmitted CRC value, the check sum for each
table section must be zero.

If the resulting check sum does not equal zero, the MPEG-2 decoder must reject
the information contained in this table.

If a CRC_error is detected, it cannot be predicted which part of the information
contained in the table is not correct. In this case, the MPEG test decoder signals
the CRC_error, but the transport stream is not checked for further errors which
are derived from the faulty content of this table (for example, a search for PMT
PIDs from a PAT or ES PIDs from a PMT).

ETR 290 states the precondition for a CRC_Error message as follows:

Indicator Precondition ReferenceÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

CRC_error
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

CRC error occurred in CAT, PAT, PMT, NIT,
EIT, BAT, SDT or TOT table

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ISO/IEC 13818-1:
Sub clause 2.4.4 /
annex B

ETS 300 468:
Sub clause 5.2

In every transport stream, coded time values derived from the system time clock
are transmitted so that the MPEG-2 decoder can link its own timing to the coder
system timing in order to decode the input stream. Each program contained in
the transport stream may have its own independent program system timing. The
Program Map Table (PMT) identifies the PID of the transport packets that
contain the PCR (Program Clock Reference) values used by the particular
program.

The specified packets contain the optional Adaptation Field in which 42 bit PCR
values are transmitted. The 42 bits contain two parts: a 33 bit PCR base and a
9 bit PCR extension. The following formulas hold for the bit structure:

PCR base (i) = (system clock frequency × t(i) DIV 300 ) % 233

PCR extension (i) = (system clock frequency × t(i) DIV 1 ) % 300

PCR (i) = (PCR base (i) × 300 ) + PCR extension (i)

A 42-bit PCR value coded this way starts again from count 0 after the elapse of
233 × 300 clocks (corresponding to a time period of approximately 26.5 hours at
27 MHz).

CRC_error (2.2)

PCR_error (2.3)
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The MPEG-2 standard also tolerates discontinuity of PCR values following one
another, provided this is indicated by the discontinuity indicator in the optional
adaptation field (AF) of the same packet. This method is primarily used for the
suppression of PCR error messages when changing programs preceded by
remultiplexing of the transport stream.

ETR 290 states the preconditions for a PCR_Error message as follows:

Indicator Precondition ReferenceÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

PCR_error
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

PCR discontinuity of more than 100 ms
occurring without specific indication

Time interval between two consecutive PCR
values more than 40 ms

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

ISO/IEC 13818-1:
Sub clauses 2.4.3.4 /
2.4.3.5

ISO/IEC 13818-4:
Sub clause 9.11.3

ETR 154: Sub clause
4.5.4

The specified intervals are the default values of the RTA. You can change the
intervals, however, on the PCR Analysis tab of the Settings window, available
through the Settings command of the RTA Configuration menu.

The DVB Measurement Guidelines also recommend additional monitoring of the
accuracy of the PCR values transmitted. Accuracy of PCR values may be
impaired by inaccurate calculation of the 42-bit PCR word width or by errors
during modification of PCR values in a remultiplex.

NOTE. The term accuracy in this case does not refer to absolute frequency
accuracy of the 27 MHz system timing, but to the fluctuation width of the PCR
values of a program, which is caused by the above mentioned errors.

ETR 290 states the precondition for a PCR_accuracy_Error message as follows:

Indicator Precondition Reference
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

PCR_accuracy_error ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

PCR accuracy of selected program is not
within ±500 ns

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

ISO/IEC 13818-1:
Sub clause 2.4.2.2

Presentation Time Stamps (PTS values) in the PES headers are transmitted by
transport stream packets of a program. They enable the MPEG-2 decoder to
identify the exact time that a transmitted data block (picture for video streams
and beginning of an audio sequence for audio streams) is to be presented. The
time stamps are transmitted with a word width of 33 bits and relate to the

PCR_accuracy_error (2.4)

PTS_error (2.5)
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27 MHz system timing sequence transmitted in the transport stream together
with the PCR values.

ETR 290 states the precondition for a PTS_Error message as follows:

Indicator Precondition Reference
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

PTS_error ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

PTS repetition period more than 700 ms ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ISO/IEC 13818-1:
Sub clauses 2.4.3.6 /
2.4.3.7 / 2.7.4

If encrypted data are contained in a packet of the transport stream, this must be
indicated in the packet header (2nd byte) within the field that is two bits wide
and is labeled transport_scrambling_control. The individual values indicate the
following:

Value (binary) Description

00 No encrypted data contained in the
packet

01, 10, 11 Defined by user

If encrypted data are to be transmitted, the MPEG-2 standard recommends the
additional transmission of the tables containing the encryption data (Conditional
Access Table, CAT) in separate packets with (0x0001) as PID and 0x01 as table
index.

The MPEG-2 standard prescribes that packet header including the optional
adaptation fields must not be transmitted in encrypted form. According to DVB
specifications (ETS 300 468), the same applies to tables containing service
information (SI tables PAT, PMT, NIT, EIT, BAT, TDT, TOT and SDT). The
only exception to this rule is the EIT (Event Information Table) when program
overviews are transmitted.

ETR 290 states the preconditions for a CAT_Error message as follows:

Indicator Precondition Reference
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

CAT_error ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Packets with transport_scrambling_control
not 00 present, but no section with table_id =
0x01 (that is, a CAT) present

Section with table_id other than 0x01 (that
is, not a CAT) found on PID 0x0001

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ISO/IEC 13818-1:
Sub clause 2.4.4

CAT_error (2.6)
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Third Priority Measurements
The Real-Time Analyzer continuously monitors the following third priority
parameters. You can check the three remaining third priority parameters with the
MTS 215 deferred-time analyzer.

These types of service information (SI) are also inserted into the transport stream
as additional data (multiplex) and contain items such as the current date, time,
and description of the TV program. Each of these tables is transmitted in the
form of packets with a given packet number (PID) and must be contained in the
transport stream at certain intervals according to the DVB specification.
However, not every SI has a different PID; packets for TDT and TOT as well as
SDT and BAT have identical PIDs. These tables are differentiated by an entry in
the table header, the so-called table index (table_id). This table_id enables an
MPEG-2 decoder working in compliance with the DVB standard to identify the
type of service information with which it is dealing.

Table A–2 is an overview of the service information according to ETS 300 468.
In the standard configuration, the RTA uses these values. You can change the
maximum interval for each table type through the Section Rates Analysis tab of
the Settings window, which opens when you choose Settings from the RTA
Configuration menu. Do not change any Maximum interval settings, however, if
you plan to use DVB-MG tests to judge DVB compliance of the input stream.

Table A–2: Overview of service information defined in ETS 300 468 

Service Information PID [hex] Table_id [hex] Max. interval [sec]

NIT 0x0010 0x40, 0x41, 0x42 10

SDT 0x0011 0x42, 0x46 2

BAT 0x0011 0x4A 101

EIT 0x0012 0x4E to 0x4F,
0x50 to 0x6F

22

RST 0x0013 0x71 —

TDT 0x0014 0x70 30

TOT 0x0014 0x73 30

Stuffing Table 0x0010 to 0x0013 0x72 —
1 Only if present.
2 For the current transport stream multiplexer.

NIT_error (3.1)
SDT_error (3.5)
EIT_error (3.6)

RST_error (3.7)
TDT_error (3.8)
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ETR 290 states the preconditions for NIT_error, SDT_error, EIT_error,
RST_error, or TDT_error messages as follows:

Indicator Precondition ReferenceÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

NIT_error
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Section with table_id other than 0x40 or
0x41 or 0x72 (that is, not an NIT or ST)
found on PID 0x0010

No section with table_id 0x40 or 0x41 (i.e.
an NIT) in PID value 0x0010 for more than
10 sec

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ETS 300 468:
Sub clause 5.2.1

ETR 211: Sub clauses
4.1, 4.4

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

SDT_error ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Sections with table_id = 0x42 (SDT, actual
TS) not present on PID 0x0011 for more than
2 sec

Sections with table_ids other than 0x42,
0x46, 0x4A or 0x72 found on PID 0x0011

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ETS 300 468:
Sub clause 5.1.3

ETR 211: Sub clauses
4.1, 4.4

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

EIT_error
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Sections with table_id = 0x4E (EIT-P/F,
actual TS) not present on PID 0x0012 for
more than 2 sec

Sections with table_ids other than in the
range 0x4E - 0x6F or 0x72 found on PID
0x0012

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ETS 300 468:
Sub clause 5.1.3

ETR 211: Sub clauses
4.1, 4.4

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

RST_error
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Sections with table_id other than 0x71 or
0x72 found on PID 0x0013

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ETS 300 468:
Sub clause 5.1.3

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

TDT_error ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Sections with table_id = 0x70 (TDT) not
present on PID 0x0014 for more than 30 sec

Sections with table_id other than 0x70, 0x72
(ST) or 0x73 (TOT) found on PID 0x0014

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ETS 300 468:
Sub clause 5.1.3

ETR 211: Sub clauses
4.1, 4.4
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The ETR211 standard prescribes minimum and maximum intervals for the
repetition of individual packets; Table A–3 lists the values for service informa-
tion (SI). The RTA uses these values in the standard configuration. You can
change the maximum interval for each table type through the Section Rates
Analysis tab of the Settings window, which opens when you choose Settings
from the RTA Configuration menu. Do not change any Maximum interval
settings, however, if you plan to use DVB-MG tests to judge DVB compliance
of the input stream.

Table A–3: SI repetition rates according to DVB 

Service information
Maximum interval
(complete table)

Minimum interval
(individual sections)

PAT 0.5 s 25 ms

CAT 0.5 s1 25 ms1

PMT 0.5 s 25 ms

NIT 10 s 25 ms

SDT 2 s2 25 ms

BAT 10 s1 25 ms1

EIT 2 s2 25 ms

RST — 25 ms

TDT 30 s 25 ms

TOT 30 s 25 ms
1 If present.
2 For current transport stream multiplex.

ETR 290 states the precondition for an SI_repetition_Error message as follows:

Indicator Precondition Reference
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

SI_repetition_error ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Repetition rate of SI tables outside of
specified limits

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

ETS 300 468:
Sub clause 5.1.4

ETR 211: Sub clause
4.4

SI_repetition_error (3.2)
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The transport stream multiplex is permitted to contain only packets with
program-specific information (PSI and SI tables), packets with certain PIDs that
are reserved in the MPEG-2 standard, and packets that are identified in a
Program Map Table (PMT).

ETR 290 states the precondition for an Unreferenced_PID message as follows:

Indicator Precondition Reference

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Unreferenced_PID ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

PID (other than PAT, CAT, CAT_PIDs,
PMT_PIDs, NIT_PID, SDT_PID, TDT_PID,
EIT_PID, RST_PID, reserved_for_fu-
ture_use PIDs, or PIDs user defined as
private data streams) not referred to by a
PMT within [0.5] seconds

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ETS 300 468:
Sub clause 5.1.3

Notice that according to the DVB Measurement Guidelines, if a program is
changed (a new PMT), an unreferenced PID may appear in the transport stream
during a transition period of no more than 0.5 s.

Unreferenced PID (3.4)
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Appendix B: Software Repair

There are two parts to this appendix. The first part explains how to create and
use an Emergency Repair Disk. The second part tells you how to reload the test
system software if the installed copy becomes corrupted.

Creating and Using an Emergency Repair Disk
An emergency repair disk, specific to the system, is supplied with each Tektronix
MPEG Test System. Whenever you upgrade the software or change your
password, it is strongly recommended that you also create a new emergency
repair disk. This will minimize the chances that you will need to completely
reload the operating software for a minor problem.

Use the emergency repair disk to restore your system to its initial setup state if
your system files become corrupt and you are unable to recover the previous start
up configuration (Last Known Good — the Windows NT startup screen option).
If you don’t have the emergency repair disk, you will have to reinstall Windows
NT. Please see the Windows NT System Guide, provided with your back-up
copy of Windows NT, for the procedure required to restore your system.

You may also need the emergency repair disk to restore user passwords if they
are forgotten. Be sure to update the emergency repair disk each time you add a
user or change a password.

CAUTION.  The files on the Emergency Repair Disk are test system-specific; that
is, the disk shipped with your test system is the ONLY  disk that will work with
your system. Do not lose this disk. If you lose the Emergency Repair Disk
provided with your test system, create a new one as described below.

To create an emergency repair disk, clearly mark a high density 3.5-inch floppy
disk as the emergency repair disk for your test system, serial number <B0xxxxx>
(be sure to write the serial number exactly as it appears on the rear panel); then
perform the following steps.

NOTE. The emergency repair disk is test system specific. Make sure that the
emergency repair disk is clearly marked with its serial number. The serial
number of your Real-Time Analyzer appears on the original emergency repair
disk and on the server rear panel, near the power input connector.

Creating an
Emergency Repair Disk



Appendix B: Software Repair

B–2 Real-Time Analyzer User Manual

1. Choose Run from the Windows NT Start menu.

2. Type rdisk  in the Run dialog box. The Repair Disk Utility  dialog box
opens.

3. Click Update Repair Info to save your current configuration. A message
appears to remind you that earlier repair information is overwritten. Click
Yes to continue.

4. When the process is complete, a message appears to ask if you wish to create
an Emergency Repair Disk. Click Yes. You are then prompted to insert a
diskette into drive A.

5. Insert a 3.5-inch disk in drive A and click OK . Rdisk formats the disk and
copies the configuration files onto it.

6. When the operation is complete, click Exit  in the Repair Disk Utility dialog
box. Remove the disk from drive A and keep it in a safe place.

Always refer to the Windows NT documentation if you need more information.

1. Verify that you have a source of setup information available (the Win-
dows NT back up software package).

2. Insert the Windows NT Setup disk.

3. Restart the Test System.

4. When the Windows NT Setup Screen appears, press R (repair).

5. When prompted, insert the emergency repair disk.

Using the Emergency
Repair Disk
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6. The emergency repair disk performs the following tasks:

� Runs CHKDSK.EXE on the WINNT and SYSTEM partitions.

� Verifies each file in the installation and replaces any that are missing or
corrupt.

� Replaces the System, Security, and Security Accounts Manager hives in
the registry.

� Reinstalls the Boot Loader (the boot sector, BOOT.INI, etc.).

Reinstalling the RTA Software
Use the procedures below to reinstall your test system software if it is accidently
deleted or becomes corrupted. Software has been supplied on CD ROM.

NOTE. The following instructions are for reinstalling MPEG Test System
software on a machine running Windows NT Workstation 4.0 only; procedures
for upgrading your software could be different. If you are installing a software
upgrade, follow the instructions provided with the upgrade kit.

Reinstalling software involves three procedures:

� Uninstalling the software

� Copying the program files

� Entering passwords for your licensed applications

For best results, uninstall the software using unInstallShield application.

1. Restart Windows NT and log in as the administrator (Username = adminis-
trator; password = MPEG2). You must log in as the administrator to install
the RTA applications.

2. Quit any applications that automatically started at login.

Uninstalling the Software
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3. Double-click the Uninstall MTS V2.5 icon in the Tektronix MPEG Test
System program group window.

4. When the dialog box asks you to confirm file deletion, click Yes.

5. When uninstall is complete, Click OK to close the Remove Programs
From Your Computer  window.

1. Double-click the My Computer icon on your Windows NT desktop and, in
the resulting My Computer window, select the (C:) disk icon. Check the
window status bar to verify that the system disk has at least 100 MB of free
space. The program will not install if the system disk has less than 100 MB
of free space.

2. Place the MPEG Test System Version 2.5 Installation Software CD ROM
into the CD ROM drive.

3. Select Run... from the Windows NT Start menu. Then enter d:\Setup.exe in
the resulting window and click OK .

Copying the Program Files
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4. In a few seconds, the Tektronix MTS200 Series window appears on the
computer screen.

5. Read the window text and then click Next to proceed to the Choose
Destination Directory window.

6. The default destination folder is C:\Mts200\. Click Next to accept the default
folder. The applications may not function correctly if you specify another
target folder.

NOTE. It is strongly recommended that you use the default destination folder.

7. The Setup Type window opens. If your test system has only real-time
analysis hardware and software, select MTS205 System software with
hardware; if your system also contains a Data Store (CARB) system, select
MTS215 System software with hardware.

8. Click Next. The Select MTS2nn Platform window opens.

9. Select the option that applies to your test system and then click Next.

CAUTION. Selecting the wrong platform will prevent use of the Real-Time
Analyzer and the Data Store system, if it is installed. Be sure to identify your
computer platform and select the appropriate option.
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10. The Select Program Folder window opens. Click Next to accept the default
folder name (Tektronix MPEG Test System) and continue. The Selection
Summary window opens.

11. Review the Destination Directory, System Product, and Start Menu Folder
selections; if all are correct, click Next to proceed with installation.

The setup program begins installing the RTA software. The activity and progress
gauges appear to show that installation is progressing. Installation proceeds
without your input (and sometimes with no apparent activity) for approximately
2 1⁄2 minutes, depending on your platform.

12. After the program group and submenu are set up, an information dialog box
reminds you to verify that the Dongle (Software Key) is installed. Verify that
the Software Key is installed on the parallel port; then click OK  to continue.

13. The Setup Complete window opens; click Finish to continue.

14. A Notepad window opens to display the Readme file. Scan the text for
important information, then select Exit  from the File menu to close the
window.

15. Another Setup Complete window opens. For best results, accept the “Yes, I
want to restart my computer now” option, remove the MPEG Test System
disc from the CD ROM drive, and click Finish to complete setup and reboot
the system.

16. Log on as MTS100. No password is required.
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17. Locate the Tektronix MPEG Test System folder on the Windows NT
desktop and double-click the folder to open the program group window.

The program group window resembles the screen capture below after full
MTS 215 installation. The Data Store Administrator icon will not be present
after MTS 205 installation. Neither the Data Store Administrator icon nor the
Real-Time Analyzer icon are present after software-only installation.

Perform the remaining steps to reenter the general password that corresponds to
the attached Software Key.

1. Double-click the License Manager icon to start the application.

Entering the General
License Password
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The Tektronix Software Protection window appears.

2. Consult the list of passwords supplied with your most recent system upgrade
and identify the General password. Use the original password supplied with
your system only if you have not upgraded the system or added any options.

3. Enter the three 6-character Hexadecimal numbers of the password in the
corresponding Tektronix Software Protection window entry fields
(lowercase characters are acceptable) and then click OK . A License message
window appears.

4. If the password is correct, click OK  to acknowledge the message. If you
made an error entering the password, click OK  and return to step 1.

When you enter the correct password, software reinstallation is complete.
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Appendix C: Real-Time Analyzer Input and Output

Figure C–1 shows Real-Time Analyzer input and output (I/O) connectors as they
appear on the Compaq Proliant rear panel; Figure C–2 shows how the same
connectors are arranged on the Compaq Prosignia (serial numbers below
B040000). Refer to RTA I/O Connections beginning on page C–2 for informa-
tion about connecting the RTA to a MPEG-2 or DVB source, to the Data Store
system, and to other equipment. For I/O port specifications, refer to Electrical
Characteristics beginning on page C–4.

LVDS/ECL/RS422
Level input

ASI outputASI input

LVDS/Mod ECL
output

Trigger input

Figure C–1: Real-Time Analyzer input and output ports (Proliant)
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1

2

3

4

5

6

7

RTA I/O

Data Store I/O
(MTS 215 only)

Figure C–2: Input and output ports, Prosignia platform

RTA I/O Connections
The Real-Time Analyzer can input and output both parallel and serial data.

The RTA accepts input through the LVDS/ECL/RS422 parallel connector or
through the ASI serial connector. In the standard configuration, either LVDS or
ECL parallel input is accepted as the default. If you provide serial input, you
must change the software configuration before monitoring an input data stream.
To change the software configuration, refer to Monitoring an Input Stream in the
Operating Basics section of this manual.

Input
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If you intend to capture and save portions of the input bitstream on the Data
Store disks, connect the parallel RTA output to the parallel Data Store I/O
connector as shown in Figure C–3 below. Use the 25-conductor straight-through
shielded cable provided with the test system, Tektronix part number
174-3799-0X. For further details, see Capturing Input Streams in the Operating
Basics section of this manual.

Install RTA-to-Data
Store board cable

RTA I/OData Store I/O

Figure C–3: RTA output to Data Store input connection

The Real-Time Analyzer can output all or part of the input stream through the
parallel and serial (ASI) output connectors.

Parallel Output. Real-Time Analyzer parallel output is active only when the RTA
is running and analysis is occurring. The output level can be either LVDS or
modified ECL. Refer to Hardware Configuration on page 3–73 for information
about setting the output level; refer to Table C–3 on page C–5 for parallel
output characteristics.

The RTA software can filter parallel output. For complete information, refer to
Filtering Configuration on page 3–91.

Serial (ASI) Output. With data input through the ASI connector, the serial output
is continuously active. With a parallel input, the serial output is disabled when
Data Storage (through the parallel output) is occurring.

Output to the
Data Store System

(MTS 215 only)

Output to Other
Equipment
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The Serial output stream is always equivalent to the input stream and is not
affected by selections made on the Filtering Configuration tab of the Real-Time
Analyzer Settings window.

Refer to Table C–5 on page C–6 for serial output characteristics.

The trigger input accepts a TTL-level (0 to +5 V) signal that you can use to
control capture of the RTA input stream to the Data Store system, if your test
system contains one. You can configure the RTA to start/stop data capture on
either the rising edge (low to high transition) or the falling edge (high to low
transition) of the trigger signal. Refer to Data Storage Start/Stop on page 3–92
for further information.

Electrical Characteristics
Tables C–1 through C–5 list the electrical characteristics of the Real-Time
Analyzer I/O ports. These tables are included here for you convenience. Refer to
the optional MPEG Test System Service Manual for additional information.

Table C–1: LVDS/ECL/RS422 Level In port
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁCharacteristic

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁDescription

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁSupplemental informationÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Connector
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

D-25
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Female; pinout as shown in Table C–2

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Input data rate ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
60 Mbits/s maximum, 1 Mbits/s minimum ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Signal amplitude, typical ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
2.0 Vp-p maximum, 100 mVp-p minimum ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Signal common mode range,
typical

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

–1.8 V to +2.5 V ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁTermination, nominal 100 ohms resistive Line to line

Timing reference Rising edge of clock

Clock-to-data timing Data must be stable to �5 ns of the rising
clock edge

Trigger Input
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Table C–2: LVDS/ECL/RS422 parallel data pinout 

Parallel input pinout Pin Function Pin Function

1 DCLK 14 DCLK

1 2 Ground 15 Ground
2

5

14
3 DATA 7 16 DATA 7

3
16

15
4 DATA 6 17 DATA 6

5

4
17

6

5 DATA 5 18 DATA 55

6
9

18 6 DATA 4 19 DATA 4

7

6
19

7 DATA 3 20 DATA 3

9

8
21

20
8 DATA 2 21 DATA 2

9
21

22 9 DATA 1 22 DATA 1
10

23 10 DATA 0 23 DATA 0

12

11

5

24 11 DVALID 24 DVALID

13
25

12 PSYNC 25 PSYNC

13 Shield

Asserted Low differential signal.

Table C–3: LVDS/MOD ECL Out port (parallel) 

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Characteristic ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Description ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Supplemental information

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Connector ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

D25 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Female; pinout as shown in Table C–2

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Signal amplitude ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Selectable by software to LVDS or modified
ECL levels

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

LVDS ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

454 mVp-p maximum, 247 mVp-p minimum ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

100 � line-to-line termination

ÁÁÁ
ÁÁÁ
ÁÁÁ
ÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Modified ECL ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

454 mVp-p maximum, 247 mVp-p minimum ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

100 � line-to-line termination

Modified Differential ECL is less than the
typical 100K ECL level of �700 mVp-p.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Common mode voltage ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

LVDS output, typical ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

0.85 V ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Modified ECL output
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

–1.80 V maximum, –1.50 V  minimum
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
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Table C–4: ASI In port 

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Characteristic ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
Description ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
Supplemental information

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Connector ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
BNC ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
Female

Input bit rate 270 Mbits/s ±100 ppm
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁTransport stream

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ60 Mbits/s max

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁContent of bit rateÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Signal amplitude, typical
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

800 mVp-p maximum, 200 mVp-p minimum
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁTermination, nominal 75 �

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Return loss, typical ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
–17 dB minimum ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
27 MHz to 270 MHz

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Data formats ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
Accepts both burst and packet modes ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Table C–5: ASI Out port 

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Characteristic ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
Description ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
Supplemental information

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Connector ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
BNC ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
Female

Output bit rate 270 Mbits/s �100 ppm
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Signal amplitude
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
880 mVp-p maximum, 500 mVp-p minimum

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Into a 75 � load
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁRise and fall times, typical

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ1.2 ns maximum

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ20% to 80%

Table C–6: Trigger input 

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Characteristic ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
Description ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
Supplemental information

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Connector ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
SMB ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
Male

Input level TTL
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ACTS (Advanced Communications Technologies and Services)
A set of telecommunication research projects financed by the European
Union.

BAT (Bouquet Association Table)
One of the tables defined by DVB-SI, the BAT provides information
regarding bouquets (collections of services marketed as a single entity).
DVB only.

CARB (Carte d’Acquisition / Restitution Binaire)
(French for Binary Acquisition/Restitution Board) The MTS 215 Data Store
system, which can capture, store, and output MPEG-2 compliant transport
streams.

CAT (Conditional Access Table)
One of the PSI tables described by the MPEG-2 standard, the CAT provides
the association between one or more CA systems, their EMM (Entitlement
Management Message) streams, and any special parameters associated with
them.

CRC (Cyclic Redundancy Check)
One of the fields described in the MPEG-2 standard, used to verify the
correctness of data in PSI and SI tables.

DVB (Digital Video Broadcast)
A project group of the European Broadcasting Union (EBU).

DVB-MG
Digital Video Broadcasting - Measurement Guidelines

DVB-SI (Digital Video Broadcast Service Information)
The DVB-SI adds the information that enables DVB IRDs to automatically
tune to particular services and allows services to be grouped into categories
with relevant schedule information. It has several tables, including: NIT,
SDT, BAT, and EIT. (NIT is also required for MPEG-2.)

DTS (Decoding Time-Stamp)
One of the fields described in the MPEG-2 standard, may be present in a
PES packet header that indicates the time that an access unit is decoded in
the T-STD.

ECM  (Entitlement Control Message)
Private conditional access information that specifies control words and
possibly other, typically stream-specific, scrambling and/or control
parameters.
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EISA (Extended Industry Standard Architecture)
The PC bus used to communicate with the CARB and PIA boards.

EIT (Event Information Table)
One of the tables defined by DVB-SI, the EIT contains data concerning
events (a grouping of elementary broadcast data streams with a defined start
and end time belonging to a common service) and programs (a concatenation
of one or more events under the control of a broadcaster, such as event name,
start time, and duration).

EMM (Entitlement Management Message)
Private conditional access information that identifies the authorization levels
or the services of specific decoders.

ETS (European Telecommunication Standard)
One of the types of documents released by ETSI.

ETSI
European Telecommunications Standards Institute.

ETR (ETSI Technical Report)
One of the types of documents released by ETSI.

IRD (Integrated Receiver / Decoder)
A receiving decoder that can automatically configure itself using the
MPEG-2 Program Specific Information (PSI).

ISO (International Standard Organization)
Organization responsible for establishing standards at the world-wide level.

NIT (Network Information Table)
One of the PSI tables described by the MPEG-2 standard and also one of the
tables defined by DVB-SI. The NIT conveys information relating to the
physical organization of the multiplex; that is, transport streams carried via a
given network and the characteristics of the network itself. Transport streams
are identified by the combination of an original network ID and a transport
stream ID in the NIT.

OPCR (Original Program Clock Reference)
Optional transport packet field defined in the MPEG-2 standard that contains
a coded time stamp used in the reconstruction of a single program transport
stream from another transport stream. The OPCR field shall be coded only in
transport stream packets in which the PCR field is present.

PAT (Program Association Table)
One of the PSI tables described in the MPEG-2 standard, the PAT gives
information about the structure of  a transport stream.
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PCR (Program Clock Reference)
One of the fields defined in the MPEG-2 standard, a time stamp in the
transport stream from which decoder timing is derived.

PES (Packetized Elementary Stream)
A structure defined in the MPEG-2 standard used to carry elementary stream
data.

PIA (Processing Interface Adapter)
The Real-Time Analyzer circuit board that filters, decodes, and analyzes the
compliance at low level of an MPEG-2 transport stream.

PID (Packet IDentifier)
One of the fields described in the MPEG-2 standard, a unique integer value
used to identify elementary streams of a program in a single or multipro-
gram TS.

PMT (Program Map Table)
One of the PSI tables described by the MPEG-2 standard, the PMT identifies
and indicates the locations of the streams that make up each service and the
location of the Program Clock Reference (PCR) fields for a service. This
table is transmitted in sections.

Probe
A user-initiated analysis.

PSI (Program Specific Information)
A set of tables described by the MPEG-2 standard, the PSI contains all the
tables that define the MPEG-2 transport stream. It consists of the PAT, PMT,
CAT, and NIT tables. (NIT is also used for DVB-SI.)

PTS (Presentation Time Stamp)
One of the fields described in the MPEG-2 standard, the PTS may be present
in a PES packet header that indicates the time that a presentation unit is
presented in the T-STD.

QUOVADIS (QUality Of Video and Audio for DIgital Television Services)
One of the ACTS projects in which MATRA COMMUNICATION is
involved, QUOVADIS deals with the definition of parameters for quality of
service in digital television systems.

RTA
Real-time Analyzer.

RST (Running Status Table)
One of the tables defined by DVB-SI, the RST gives a quick updating
mechanism for the status information carried in the EIT.

SDT (Service Description Table)
One of the tables defined by DVB-SI, the SDT contains data describing the
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services in the system. Examples include: names of services and the service
provider.

SI (Service Information)
Set of tables defined by DVB-SI, SI provides information on services and
events carried by different Multiplexes, and even other networks. SI is
structured as six tables (PAT, NIT, CAT, SDT, EIT, and BAT). The applica-
tions are only concerned with NIT, BAT, SDT, and EIT.

ST (Stuffing Table)
One of the tables defined by DVB-SI, the ST provides stuffing sections.

TDT (Time & Date Table)
One of the tables defined by DVB-SI, the TDT carries the current time and
date information.

TOT (Time Offset Table)
One of the tables defined by DVB-SI, the TOT gives information about a
local time offset in a given area.

TS (Transport Stream)
A bit stream that contains 0 or more elementary streams combined in a
manner that conforms to the MPEG-2 standard.

T-STD (Transport Stream System Target Decoder)
Described by the MPEG-2 standard, the T-STD is a hypothetical reference
model of a decoding process used to define the semantics of a TS.
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Index
A
Absence of referenced PID error analysis, 3–9
Acquisition stopped (error message), 2–28
Active view menu, 3–30
adaptation field, A–4, A–7, A–8
ADF flag error analysis, 3–13
Analysis, transport rate, 3–1
Analysis menu, 3–28
Application window, 3–23
Ask before saving, 3–96
Automatic analysis, 3–7

settings, 3–82
Automatic trace sequencing, 2–30, 3–93

B
BAT, A–6, A–9
Buffer filling, 1–2, 3–7

C
Capturing input streams, 2–25
CAT, A–6, A–8
CAT_error, A–8
changing programs, A–4, A–7
Client window pane, 3–48
Clock symbol, 3–35
Conditional Access Table, A–8
Configuration

delete, 3–70
Load (restore saved), 3–69
Restore standard, 3–70
Save, 3–69

Configuration menu, 3–26
Continuity Counter (Statistic view), 3–55
Continuity counter error analysis, 3–12
Continuity_count_error, A–3
CRC, A–6
CRC check (analysis), 3–16
CRC_error, A–6
Cyclic Redundancy Check, A–6

D
Data Storage, 2–25

menu, 3–28
Start/Stop, 2–27, 3–92

DEN signal, 3–73
discontinuity indicator, A–4, A–7
Dongle, B–6
DVB, General option, 3–74
DVB-MG

measurements, A–1
view, 2–12, 3–57

E
EIT, A–6
EIT_error, A–9
Emergency Repair Disk, B–1
encryption data, A–8
Error limits

PCR probe, 3–19
transport rate, 3–4

Event Information Table, A–8
Event trace, 3–95
Event Viewer, 3–45, 3–75
Exiting the application, 1–3

F
File already exists (error message), 2–28
Filtering Configuration, 2–26

settings, 3–91

G
General settings, 3–74
Ghost packet error analysis, 3–9
Graphic View settings, 3–81

H
Hardware configuration settings, 3–73
Help menu, 3–29
Hierarchic view, 2–5, 3–33

settings, 3–78

I
I/O connections, C–2
Icons, Hierarchic view, 3–34
Input connectors, C–2
InterSI probe, 2–23, 3–16, 3–90
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L
Lock symbol, 3–36
Logging on, 1–1
Logins, 1–1

M
Mask Discontinuities, 3–88
Maximum interval between sections analysis, 3–13
Menu bar, 3–25
Menus

active view, 3–30
Analysis, 3–28
Configuration, 3–26
Data Storage, 3–28
Help, 3–29
icon shortcut, 3–41
View, 3–27
Window, 3–29

Message View settings, 3–76
Messages, 3–43
Minimum interval between sections analysis, 3–15
Monitoring an input stream, 2–2
MPEG-2, General option, 3–74

N
NIT, A–6
NIT_error, A–9
null packet, A–4
Null Packet with ADF error analysis, 3–13
Null packet with PUSI error analysis, 3–11

O
Options, 3–72
Output connectors, C–3

P
Padlock symbol, 3–36
Password, changing, emergency repair disk, 1–2
PAT, A–3, A–6
PAT_error, A–3
PAUSE, 3–32
PCR, A–4, A–6
PCR analysis

settings, 3–65, 3–87
view, 3–64

PCR probes, 2–17, 3–18, 3–89

PCR/OPCR flags error analysis, 3–13
PCR_accuracy_error, A–7
PCR_error, A–6
PID, A–5
PID 0x47 error analysis, 3–11
PID Allocation (Statistic view), 3–3, 3–53
PID_error, A–5
PMT, A–4, A–6, A–12
PMT PID with TSC error analysis, 3–12
PMT_error, A–4
Presentation Time Stamp, A–7
Printing

messages, 3–45
Section analysis view, 3–62

Probes, 2–16, 3–16
InterSI, 2–23, 3–16, 3–90
PCR, 2–17, 3–18, 3–89
PTS/DTS, 2–20, 3–20, 3–90
removing, 3–90
Section syntax, 3–21, 3–89

Probes List, 3–88
Profile, 3–69
program, A–5
Program Allocation (Statistic view), 3–2, 3–52
Program Association Table, A–3
Program Clock Reference, A–6
Program Map Table, A–4, A–12
PSI, A–6
PTS, A–7
PTS/DTS analysis view, 3–63
PTS/DTS probes, 2–20, 3–20, 3–90
PTS_error, A–7
Pulldown menus. See Shortcut menus

R
Registry editor, 3–70
remultiplexing, A–7
Repair Disk Utility, B–2
Reserved PID with TSC error analysis, 3–11
RST_error, A–9
Rta.trp, 2–26, 2–28

S
Scrambling without CAT error analysis, 3–9
SDT, A–6, A–9
SDT_error, A–9
section, A–4, A–6
Section analysis view, 3–59
Section number analysis, 3–15
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Section rate analysis, maximum and minimum
intervals, 3–83

Section rate view, 3–62
Section rates analysis, settings, 3–13, 3–83
Section Syntax probes, 3–21, 3–89
service information, A–8, A–9
Settings, 3–72
Settings window, 3–68
Settling Filter, 3–19
Shortcut menus, 3–41

Message view, 3–47
Shutting down the computer, 1–3
SI_repetition_error, A–11
Software key. See Dongle
Software repair, B–1
Start acquisition, 2–27, 3–92
Start condition, 3–92
Starting the application, 1–2
Statistic analysis settings, 3–9, 3–85
Statistic view, 2–9, 3–50
Status bar, 3–32
Stop acquisition, 3–93
Stop conditions, 3–93
Sync_byte_error, A–3
SyncByte, A–2
system time, A–6

T
Table ID error analysis, 3–15
table_id, A–4, A–9
TDT, A–9
TDT_error, A–9
TEI. See Transport error indicator
Title bar, 3–25
Toggle Docking, 3–48
Toolbar, 3–30
TOT, A–6, A–9
TP Error Indicators (Statistic view), 3–55

Transport error indicator analysis, 3–10
Transport rate

analysis, 3–1
interval, 3–4

Transport rate analysis, settings, 3–84
Transport_error, A–5
transport_error_indicator, A–5
transport_scrambling_control, A–8
Trigger

configuration, 3–73
Data storage start condition, 3–93
input, C–4

TS_Sync_Loss, A–2

U
Uninstalling MTS software, B–3
UNP. See Unsynchronized packet error analysis
unreferenced PID, A–12
Unsynchro Packets (Statistic view), 3–56
Unsynchronized packet error analysis, 3–10
Use DEN signal, 3–73

V
Version number analysis, 3–15
View

PCR analysis, 3–65
PTS/DTS analysis, 3–64
Section analysis, 3–60
Section rate, 3–63

View menu, 3–27

W
Window, application, 3–23
Window menu, 3–29
Windows NT, initialization, 1–1
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